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Introduction
This guide explains how to administer and use Siebel Professional Services 
Automation. 

The audience for this guide includes:

Consultants Persons who provide consulting services to customers, and 
who charge for their time and expenses.

Consultant Managers Persons who manage consultants and consulting projects.

Engagement Managers Persons who oversee relations with customers and are 
responsible for business development and practice 
management.

Resource Managers Persons who assign consultants to various projects and 
manage resources.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers

Persons who plan, implement, and configure Siebel 
applications, possibly adding new functionality. A developer 
is typically someone from the Information Services 
department.
Version 7.5, Rev. A Siebel Professional Services Automation Guide 11



Introduction

How This Guide Is Organized
How This Guide Is Organized
This guide provides information necessary for administering and using Siebel 
Professional Services Automation. Chapters of this guide focus on typical tasks, 
separated into administrator procedures and end-user procedures.
12 Siebel Professional Services Automation Guide Version 7.5, Rev. A



Introduction

Revision History
Revision History
Siebel Professional Services Automation Guide, Version 7.5, Rev. A

January 2003 Bookshelf
Table 1. Changes Made in Rev. A for January 2003 Bookshelf

Topic Revision

“Project Management” Added administrative procedures previously 
located in Siebel Applications Administration 
Guide. Added tables of field descriptions to a 
number of procedures.

“Setting Up Contract and Work Order 
Templates (Administrator)”

Updated incorrect cross-reference to additional 
information about proposals.

“Adding Project Revenues Using 
SmartScripts”

Added this topic.

“Adding Project Revenues Using 
Revenue Plans”

Added this topic.

“Viewing the Project Revenue 
Spreadsheet”

Added this topic.

“Resource Management” Moved administrative procedures to “Project 
Management” chapter.
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Revision History
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Overview of Siebel Professional Services
Automation 1
Siebel Professional Services Automation was designed in consultation with leading 
professional services organizations specifically to meet the needs of consulting and 
service organizations. 

Siebel Professional Services Automation allows companies to maximize their 
market potential by closing more business and providing a solution for managing 
projects. Siebel Professional Services Automation helps service delivery teams win 
more deals, deliver services on time with high quality, and accurately track resource 
needs, and delivery dates.

Siebel Professional Services Automation provides support for the entire professional 
services process. Organizations use Siebel Professional Services Automation to 
manage leads for customer engagements, define project scope, and work 
breakdown structures, create contracts, manage resource assignments, select and 
track subcontractors, manage time, expenses and materials, expose and resolve 
risks related to the project, creation of customer invoices, and guarantee customer 
satisfaction.
Version 7.5, Rev. A Siebel Professional Services Automation Guide 15



Overview of Siebel Professional Services Automation

Siebel Professional Services Automation Business Process
Siebel Professional Services Automation Business 
Process

Figure 1 is a diagram that represents a typical Siebel Professional Services 
Automation Business Process.

Figure 1. Professional Services Automation Business Process
16 Siebel Professional Services Automation Guide Version 7.5, Rev. A



Overview of Siebel Professional Services Automation

Benefits
Benefits
Siebel Professional Services Automation helps professionals by providing:

■ Opportunity Management

■ Project Management

■ Risk Tracking and Management

■ Automated Proposal Generation

■ Resource Management

■ Microsoft Project Integration

■ Time and Expense Reporting

■ Contract Management

■ Financial Management
Version 7.5, Rev. A Siebel Professional Services Automation Guide 17
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Benefits
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Opportunity Management 2
This chapter describes the Opportunity Management functionality and provides a 
business scenario and end-user procedures.

Opportunity Management allows engagement managers to coordinate information 
with sales representatives and access critical sales and customer data. Opportunity 
assessments create tremendous business value by allowing engagement managers 
to identify and focus on critical opportunities.

You can access different Opportunities screen views to:

■ View your own opportunities with information that may include contacts, 
activities, products, decision issues, competitors, estimated revenue, probability 
of closure, and sales stage.

■ Enter information about new opportunities.

■ Track the status of an opportunity through the sales cycle from creation to 
closure.

■ Update information about opportunities as they move through the sales cycle.

■ Generate presentations, quotes, and proposals based on opportunities.

■ Create relationships between projects and accounts and opportunities.

For more information about using opportunities, see Siebel Sales User Guide.
Version 7.5, Rev. A Siebel Professional Services Automation Guide 19



Opportunity Management

Business Scenario for Opportunity Management
Business Scenario for Opportunity Management
This scenario provides an example of a process performed by an engagement 
manager for opportunity management. Your company may follow a different 
process according to its business requirements.

The engagement manager at a large professional services company receives a call 
from a prospective customer. The prospective customer is interested in having the 
engagement manager’s team work on an opportunity. The engagement manager 
enters information about the opportunity into Siebel Professional Services 
Automation and associates it with the project in question. She then associates the 
project with the customer’s account, which already exists in her Siebel application.
20 Siebel Professional Services Automation Guide Version 7.5, Rev. A



Opportunity Management

Example Process for Opportunity Management
Example Process for Opportunity Management
This is an example of a process for opportunity management. Your company may 
follow a different process according to its business requirements.

End-User Procedures
1 Associate a project with an opportunity. For information, see “Associating a Project 

with an Opportunity” on page 22.

2 Associate a project with an account. For information, see “Associating a Project 
with an Account” on page 23.
Version 7.5, Rev. A Siebel Professional Services Automation Guide 21



Opportunity Management

Associating a Project with an Opportunity
Associating a Project with an Opportunity
Associating projects with an opportunity is critical to guarantee that sales 
representatives are collaborating with the proper professional services personnel to 
jointly develop and scope the project.

To associate a project with an opportunity

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the opportunity will be 
associated.

4 Click the select button in the project record’s Opportunity field to display the 
Pick Opportunity dialog box.

5 Select the opportunity you want to associate with the project, and then click OK.

NOTE: End users can also create new projects from the Projects view in the 
Opportunities screen. This automatically associates the project with an opportunity.
22 Siebel Professional Services Automation Guide Version 7.5, Rev. A



Opportunity Management

Associating a Project with an Account
Associating a Project with an Account
End users can also associate a project with an account, as described in the following 
procedure.

To associate a project with an account

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the account will be associated.

4 Click the select button in the project record’s Account field to display the Pick 
Account dialog box.

5 Select the account you want to associate with the project, and then click OK.
Version 7.5, Rev. A Siebel Professional Services Automation Guide 23



Opportunity Management

Associating a Project with an Account
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Project Management 3
This chapter describes project management functionality and provides a business 
scenario and administrative and end-user procedures. A project is an effort that 
involves the completion of multiple tasks, multiple activities, or both, over time. In 
a project, some tasks or activities may need to be performed in a specific order.
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Project Management

Business Scenario for Project Management
Business Scenario for Project Management
This scenario provides an example of a process performed by a Siebel administrator, 
an engagement manager, and the manager’s project team members. Your company 
may follow a different process according to its business requirements.

A Siebel administrator at a large consulting company is responsible for setting up 
Siebel Professional Services Automation so that users can manage their projects. He 
has to set up financial components, employee records, project resources, roles, and 
skills and competencies. He is also responsible for creating templates such as 
contract and work order templates and project activity templates. He has to set up 
Microsoft Project field mappings to make sure that users can import and export data 
between Microsoft Project and Siebel Professional Services Automation. He also 
may need to set up project-related list of values for drop-down lists used with 
projects. In order for projects to be billed properly, the Siebel administrator creates 
a cost list and associates cost list items with it. He also creates a rate list and 
associates rates and resources with it.

The company’s engagement manager has been given the task of performing a global 
rollout and implementation of a Siebel Incentive Compensation for large hotel 
chain. She has created the project in Siebel Professional Services Automation, 
associated the appropriate contacts to it, and provided her team members with 
access to the project. She is now in the process of determining the tasks or 
milestones that need to be completed to have a successful and profitable project. 
She creates a number of activities, manually and using activity plans.

At this point, the engagement manager breaks each milestone down to its 
component parts by tasks. After she creates a team workbook for the project, sets 
up roles, associates skills and competencies with each workbook role, sets rates for 
project staff, and creates and submits resource requests, she assigns the tasks. She 
can use the Tasks view to assign tasks and set expected completion dates. She is 
attempting to build the skeletal project plan that she will later export to Microsoft 
Project. By assigning tasks, the engagement manager can give the other members 
of her team an idea of the work each will do on the project.
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As the engagement manager’s team members finish their assigned tasks, they can 
assess and add risks to the project, create risk resolution activities, create status 
reports, and associate risks with status reports. Meanwhile, the engagement 
manager can monitor the team’s progress from the My Team’s Projects view. Her 
team can attach files of related information, including diagrams, as necessary. 
Because these files are embedded in the Siebel application, anyone on the team can 
open the files and review the work to be done on the project. They can also add 
notes, create orders for project materials, and change delivery status of the project.
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Example Process for Project Management
This is an example of a process an administrator and an end user may follow to 
manage projects. Your company may follow a different process according to its 
business requirements.

Administrator Procedures
The following are administrator procedures for managing projects:

1 Set up financial components. Financial components such as currencies and 
expense types need to be set up for use in projects. For more information, see 
“Setting Up Financial Components (Administrator)” on page 32.

2 Set up employee records. Employee records must be created before employees can 
be assigned to work on particular projects. For more information, see “Setting 
Up Employee Records (Administrator)” on page 33.

3 Display existing project resources. Existing product records for the services you 
offer, such as consulting hours for field engineers or field technicians need to be 
displayed for inclusion in projects. This is part of setting up the rate book for 
your organization. For more information, see “Displaying Existing Project 
Resources (Administrator)” on page 35.

4 Add a new project resource. New product records for the services you offer, such 
as consulting hours for field engineers or field technicians need to be added to 
the database if the existing product records don’t match the needs of a project. 
This is part of setting up the rate book for your organization. For more 
information, see “Adding New Project Resources to the Product List 
(Administrator)” on page 36.

5 Create a role. Administrators must create the roles that project managers identify 
as needing to be filled on the project team. For more information, see “Creating 
Roles (Administrator)” on page 37.

6 Set up skills and competencies. Skills and competencies that are needed on the 
project team must be specified during project resource management to help 
assign people to project tasks. For more information, see “Setting Up Skills and 
Competencies (Administrator)” on page 38.
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7 Set up contract and work order templates. Allow end users to create agreement, 
contract, and work order documents by setting up Siebel Proposals templates 
and modifying them to meet the needs of your company. For more information, 
see “Setting Up Contract and Work Order Templates (Administrator)” on 
page 39.

8 Set up a project activity template. Set up project activity templates to 
automatically create the milestones or activities that should be followed for a 
project. For more information, see “Setting Up Project Activity Templates 
(Administrator)” on page 40.

9 Set up Microsoft Project field mappings. A mapping file that defines field mappings 
between Microsoft Project and Siebel Professional Services Automation must be 
set up to export and import data between these two applications. For more 
information, see “Setting Up Microsoft Project Field Mappings (Administrator)” 
on page 41.

10 Set up project-related list of values entries. You may want to set up some values for 
drop-down lists used with projects. This is done by adding values to the 
appropriate list of values. For more information, see “Setting Up Project-Related 
List of Values Entries (Administrator)” on page 42.

11 Create a cost list. You can create cost lists to record the estimated costs to your 
organization for providing specified services. For more information, see 
“Creating a Cost List (Administrator)” on page 44.

12 Associate cost list items with a cost list. Once you create a cost list, you can 
associate project resources with it. For more information, see “Associating Cost 
List Line Items with a Cost List (Administrator)” on page 45.

13 Create a rate list. You may want to create rate lists specify rates for services and 
the people who provide those services. For more information, see “Creating a 
Rate List (Administrator)” on page 46.

14 Associate rates and project resource products with a rate list. Once you create a rate 
list, you can associate project resources with it. For more information, see 
“Associating Rates and Project Resources with a Rate List (Administrator)” on 
page 47.

End-User Procedures
The following are end-user procedures for working with projects:
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1 Create a project. For information, see “Creating Projects” on page 49.

2 Associate a contact with a project. For information, see “Associating Contacts with 
a Project” on page 55.

3 Provide access to a project. For information, see “Providing Access to a Project” 
on page 56.

4 Create activities using an activity plan. For information, see “Creating Activities 
Using Activity Plans” on page 57.

5 Create an activity manually. For information, see “Creating Project Activities 
Manually” on page 58.

6 Create a task. For information, see “Creating Tasks” on page 60.

7 Add an activity to a task. For information, see “Adding Activities to a Task” on 
page 62.

8 View tasks. For information, see “Viewing Tasks” on page 63.

9 Use the team workbook. For information, see “Using the Team Workbook” on 
page 64.

10 Set up roles in a team workbook for a project. For information, see “Setting Up Roles 
in a Project Team Workbook” on page 65.

11 Associate skills and competencies with team workbook roles. For information, see 
“Associating Skills and Competencies with Team Workbook Roles” on page 68.

12 Set rates for project staff. For information, see “Setting Rates for Project Staff” on 
page 69.

13 Add subcontractor information. For information, see “Adding Subcontractor 
Information” on page 71.

14 Associate a subcontractor resource with a project. For information, see “Associating 
a Subcontractor Resource with a Project” on page 72.

15 Assess and add risks to a project. For information, see “Assessing and Adding 
Risks to a Project” on page 73.

16 Create a risk resolution activity. For information, see “Creating Risk Resolution 
Activities” on page 74.
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17 Create a status report for a project. For information, see “Creating a Status Report 
for a Project” on page 75.

18 Associate a risk with a status report. For information, see “Associating Risks with 
a Status Report” on page 77.

19 Attach a file to a project. For information, see “Attaching a File to a Project” on 
page 78.

20 Add a note to a project. For information, see “Adding a Note to a Project” on 
page 78.

21 Create an order for project materials. For information, see “Creating an Order for 
Project Materials” on page 79.

22 Change the delivery status of a project. For information, see “Changing the 
Delivery Status of a Project” on page 80.
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Setting Up Financial Components (Administrator)
You must set up several financial components in your Siebel application before you 
go into production. These components are: 

■ Currencies (unless your Siebel application will use only one currency)

■ Currency Conversions (unless your Siebel application will use only one 
currency)

■ Expense Types

■ Periods

It is recommended that you also set up the following financial component before 
your Siebel application goes into production:

■ Payment Terms

For more information about setting up these components, see information about 
ongoing application administration tasks in Siebel Applications Administration 
Guide.
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Setting Up Employee Records (Administrator)
Before you can assign employees to work on particular projects, you must create 
employee records. This is normally part of the initial setup for a Siebel application. 
For information about setting up employee records, see Security Guide for Siebel 
eBusiness Applications and Siebel Applications Administration Guide.
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Overview of Rate List and Cost List Management 
(Administrator)

This section provides background information about setting up and using rate lists 
and cost lists for projects. Rate lists specify what you charge your customers for 
various services. Cost lists specify what it costs your organization to provide those 
services. The difference between the rate and the cost for a given service is your 
profit margin for that service. Your organization can establish multiple rate lists and 
cost lists for use in different geographical areas or with different customers, but 
each rate list is associated with exactly one cost list.

It is strongly recommended that you use the following sequence of tasks to set up 
your rate lists and cost lists for project management:

1 Set up product records for the services you offer, such as consulting hours for 
field engineers, field technicians, and so on. For more information about this 
task, see “Displaying Existing Project Resources (Administrator)” on page 35 
and “Adding New Project Resources to the Product List (Administrator)” on 
page 36.

2 Create cost lists that estimate what it costs your organization to deliver each 
service and associate products with it. For more information about this task, see 
“Creating a Cost List (Administrator)” on page 44 and Associating Cost List Line 
Items with a Cost List (Administrator) on page 45.

3 Create rate lists to specify what you charge for each service, associate products 
with it, and associate each rate list with a cost list. For more information about 
this task, see “Creating a Rate List (Administrator)” on page 46 and Associating 
Rates and Project Resources with a Rate List (Administrator) on page 47.

4 As part of the process of creating each project, associate the project with a rate 
list. For more information about this task, see “Creating Projects” on page 49.

5 Any record added to the Team Workbook should each have the Resource field 
populated with a product record created in Step 1. For more information about 
this task, see “Setting Rates for Project Staff” on page 69.

Completing these tasks in the specified order allows rates and costs to default when 
you use the Team Workbook to staff projects. You can modify them as needed.
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Displaying Existing Project Resources (Administrator)
When you create lists of the rates that you will charge for services to your 
customers, each rate will be associated with a project resource. A project resource 
is a special kind of product that represents a person with particular skills that are 
needed for the project. For example, typical project resource products might include 
Consultant, Field Engineer, and Field Technician. As you plan projects, you assign 
project resources to project tasks as part of the process of determining project costs 
and scheduling.

The following procedure explains how to display a list of the project resource 
products already defined in your Siebel application.

To display existing project resources

1 Navigate to the Product Administration screen.

2 In the More Info form, click the show more button, and then click Query.

3 In the More Info query form, click the Project Resource check box.

4 In the More Info query form, click the menu button, and then click Run Query.
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Adding New Project Resources to the Product List 
(Administrator)

You must define project resources before you can select them for a project. You must 
set up resources as products, so that these resources can be added in the rate and 
cost lists. The following procedure explains how to add a new project resource 
product.

To add a project resource to the product list

1 Navigate to the Product Administration screen.

2 In the Products list, add a new record.

3 In the Product field of the new record, enter a resource name, such as 
consultant.

4 In the More Info form, click the show more button and then select the Project 
Resource check box.

5 Complete any other fields as needed. For more information on the fields 
available, see Product Administration Guide.

NOTE: If the product can be ordered or if the product can be listed as a quote item 
in a quote, select the Orderable check box.

6 From the Show drop-down list in the More Info form, select Category to display 
a Product form and a More Info list.

Adding products to categories allows users access to the product. Categories are 
how product visibility is controlled. You must also add a product to a category 
to make it selectable in a quote and to make it visible in eSales Web pages.

7 In the More Info list, click New to display the Add Subcategories dialog box.

8 In the Add Subcategories dialog box, select the category to which the product 
(project resource) belongs, and then click OK.
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Creating Roles (Administrator)
As part of the process of creating a project, a project manager identifies the roles 
that need to be filled on the project team, and the approximate start and end date 
for each role. These roles must first be created by the administrator before a project 
manager can add them to a project.

To create a role

1 From the application-level menu, choose View > Site Map > Application 
Administration > List of Values.

NOTE: You may want to query to see if the role you want to create already exists 
in the List of Values screen. To find existing roles, query for records with the 
value of PS_PROJECT_TEAM_ROLE in the Type field. 

2 In the List of Values, add a new record.

3 In the Type field, enter PS_PROJECT_TEAM_ROLE.

4 In the Display Value and Language-Independent Code fields, enter the name of 
the new role.

5 Complete other fields in the new record as desired.
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Setting Up Skills and Competencies (Administrator)
In Siebel Professional Services Automation, a skill designates a general area of 
expertise such as Language, and a competency designates a more specific area of 
expertise within that skill, such as Spanish. During project resource management, 
you specify skills and competencies that are needed on the project team to help you 
assign appropriate people to project tasks. These skills and competencies must be 
defined ahead of time. For information about defining skills and associating them 
with employees, see Siebel Assignment Manager Administration Guide. For 
information about associating skills and competencies with project roles, see 
“Associating Skills and Competencies with Team Workbook Roles” on page 68.
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Setting Up Contract and Work Order Templates 
(Administrator)

The Siebel Professional Services Automation Agreements module uses Siebel 
Proposals technology to create agreement, contract, and work order documents. To 
allow users to create these documents, set up Siebel Proposals templates and 
modify them to meet the needs of your company. For more information about Siebel 
Proposals templates, see Siebel Applications Administration Guide.
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Setting Up Project Activity Templates (Administrator)
Organizations can create project activity templates (or plans), which help focus 
their consultants on best practices when working on particular types of projects. 
These project activity templates automatically create the milestones or activities 
that should be followed for a project. For more information, see Siebel Applications 
Administration Guide.
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Setting Up Microsoft Project Field Mappings 
(Administrator)

The tasks and resources you define for a project in your Siebel application can be 
exported to and imported from a Microsoft Project .mpp file. This allows you to use 
Microsoft Project’s ability to show how scheduling and resource changes can affect 
final delivery dates. To export and import data between these two applications you 
must set up a mapping file that defines field mappings between the two 
applications. For information about how to set up Microsoft Project field mappings, 
see Chapter 5, “Microsoft Project Integration.”
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Setting Up Project-Related List of Values Entries 
(Administrator)

You may need to set up some values for drop-down lists used with projects. You do 
so by adding values to the appropriate list of values (LOVs). The following 
procedure explains how to add an entry to a LOV.

For more information about LOVs, see Siebel Applications Administration Guide. 
For information about using lists of values for a global deployment, see Global 
Deployment Guide.

To add a new value to a project-related list of values

1 From the application-level menu, choose View > Site Map > Application 
Administration > List of Values. 

2 In the List of Values list, click Query.

3 In the Type field, click the select button to display the Pick Value Type dialog 
box, and then complete the following substeps:

a In the Pick Value Type dialog box, use query or find to select the name (here 
called Type) of the list of values to which you want to add a value.

For information about list of values types that are commonly used for 
projects, see Table 1 on page 43. 

b In the Pick Value Type dialog box select the record for the type you want, and 
then click OK to close the dialog box and return to the main window.

4 In the List of Values list, click the menu button and then click Run Query.

The current values for the selected list of values type appear.

5 In the List of Values list, add a new record.

6 In the Type field of the new record, enter the same type you selected in Step 3 
of this procedure.

7 In the Display Value and Language-Independent Code fields, enter the new value 
that you want to add to the selected list of values.

8 Select the check box in the Translate field.
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9 In the Language Name field, click the select button, select the language in the 
Language Name dialog box, and click OK.

Table 1. Most Commonly Used Project-Related List of Values Types

Type Description

PROJECT_CLASS Classifications used to separate employee hours into 
utilization categories. The project class is the default 
class on an employee’s time sheet line items.

PROJECT_TYPE Describes the nature of the project.

PROJECT_STATUS Affects the default sort order of the projects. Useful in 
queries.

PROJ_BILLING_TYPE Explains how you plan to bill the customer.

PROJECT_PARTNER_ROLE The role a partner would play while engaged on a 
project. Typical values include consultant, business 
analyst, and developer. 

PS_MPP_FIELD_TYPE Defines the fields you can choose from when setting 
up Microsoft Project field mappings. For more 
information about Microsoft Project and Siebel 
Professional Services Automation, see Chapter 5, 
“Microsoft Project Integration.” 

PS_MPP_MAP_BC_SEL The business component to be used for a mapping 
category when creating Microsoft Project Plan 
mappings.

PS_PROJECT_TEAM_ROLE A role a member on the team workbook will play. This 
is defined per project. Team workbook members can 
play more than one role; enter them more than once 
on the team workbook.

PS_PROJECT_TEAM_STATUS The assignment status of an employee on the team 
workbook. Used for reserving resources or staffing 
resources. Allows you to play “what-if” with your 
staffing before finalizing your plans.

PSTASK_ALT_TYPE A task entered for a project. These are the values for 
the Type field in Project Task. PSTASK_ALT_TYPE is a 
child type of PSTASK_TYPE. If you add a new LOV 
value to PSTASK_ALT_TYPE, you need to specify the 
new LOV value in PSTASK_TYPE.
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Creating a Cost List (Administrator)
Cost lists record the estimated costs to your organization for providing specified 
services. Cost lists are used along with rate lists. The difference between the cost of 
a service and the rate you charge for that service is your profit margin for that 
service. Your organization can have multiple cost lists, to reflect how costs differ in 
various locations or other situations.

The following procedures describe how to set up a cost list. First you must create a 
cost list record, and then you associate cost list line items with it.

To create a cost list record 

1 From the application-level menu, choose View > Site Map > Pricing 
Administration > Cost List.

2 In the Cost Lists More Info form, add a new record.

3 Complete the necessary fields. Some fields are described in the following table.

Field Comments

Cost List Required. Name to identify the cost list.

Created Read-only. Date and time the cost list record was created. 
Automatically populated.

Created By User ID of the person who created the cost list. Automatically 
populated.

Description Text field for information about the cost list.

Effective From Required. First date on which the cost list is valid and available.

Effective To Last date on which the cost list is valid and available.

Organization Portion of your company that uses and maintains the cost list. 
Defaults to the organization of the user who creates the record.

Updated Last date on which the record was modified. Automatically 
populated. Read-only.

Updated By User ID of the last person to modify the record. Automatically 
populated. Read-only.
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Associating Cost List Line Items with a Cost List 
(Administrator)

The line items in a cost list map to products (project resources). The following 
procedure explains how to associate cost list line items and project resources with 
a cost list. This procedure should be used after you have completed “Adding New 
Project Resources to the Product List (Administrator)” on page 36.

To associate a cost list line item with a cost list

1 From the application-level menu, choose View > Site Map > Pricing 
Administration > Cost List.

2 In the Cost Lists list, select the cost list that you want to add costs to.

3 In the selected record, click the hyperlink in the Cost List field to display a Cost 
List form and a Cost List Line Items list.

4 In the Cost List Line Items list, click New to display the Add Internal Products 
dialog box.

5 In the Add Internal Products dialog box, select the resource product to be added 
to the cost list, and then click OK.

6 In the Cost List Line Items list, enter the cost of the resource product in the 
Standard Cost field.
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Creating a Rate List (Administrator)
Rate lists are like price lists, but they refer to services and the people who provide 
those services. Instead of a price for a hard drive, for instance, you specify an hourly 
rate for a consultant. You can create multiple rate lists to charge different rates or 
use different currencies in different geographical areas or to provide special rates on 
particular projects or for favored customers. Each rate list must be associated with 
exactly one cost list.

To set up a rate list, you must first create a rate list record and then associate charge 
rates with the rate list.

To create a rate list record

1 From the application-level menu, choose View > Site Map > Pricing 
Administration > Rate List.

2 In the Rate Lists More Info form, add a new record.

3 Complete the necessary fields. Some fields are described in the following table.

Field Comments

Cost List List that specifies the cost of the selected service to your organization. 
Each rate list can be associated with exactly one cost list.

Currency Currency used to charge for the service

Description General information about the selected rate list. Typically, this field 
would include information about where this rate list should be used 
or for which customers.

Effective From Required. First date on which the rate list is valid and available. 

Effective To Last date on which the rate list is valid and available.

Last Updated Date on which the current record was last modified. Automatically 
populated. 

Organization Portion of your company that uses and maintains the current rate list. 
Defaults to the organization of the user who creates the record.

Rate List Required. Name that identifies the rate list. It is recommended that 
you include information in the rate list name that describes where the 
list should be used or for which customers.

Updated By User ID of the last user to modify the current record. Automatically 
populated.
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Associating Rates and Project Resources with a Rate List 
(Administrator)

The following procedure explains how to associate rates and project resources with 
a rate list. This procedure should be used after you have completed “Adding New 
Project Resources to the Product List (Administrator)” on page 36.

To associate rates and project resources with a rate list

1 From the application-level menu, choose View > Site Map > Pricing 
Administration > Rate List.

2 In the Rate Lists list, select the rate list that you want to add rates to.

3 In the selected record, click the hyperlink in the Rate List field to display a Rate 
List form and a Rate List Line Items list.

4 In the Rate List Line Items list, click New to display the Add Position Types 
dialog box.

NOTE: The resources that appear in the Add Position Types dialog box have been 
defined as products in the Siebel application. For example, the project resource 
that you created in “Adding New Project Resources to the Product List 
(Administrator)” on page 36.

5 In the Add Position Types dialog box, select the project resource to be added to 
the rate list, and then click OK.

The selected project resource appears in the Resource field. 

6 In the Rate List Line Items list, complete the remaining fields. Some fields are 
described in the following table.

Field Comments

Rate/Hour Standard charge per hour for the specified project resource product.

Resource Project resource product for which the rate is being specified, such as 
Consultant or Field Engineer.
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About Multiple Rate Schedules (Administrator)
In addition to setting up billing rates by resource in the Rate List Administration 
view, you can:

■ Set up billing rates in multiple currencies, by creating a rate list with another 
currency.

■ Set up unique billing rates for special customers or projects, by creating rate lists 
used only for those customers or projects. You might name the rate list for that 
customer or project, so that it is clear that the rate list should only be used in 
those cases.
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End users can create and work with projects in three different areas of the Siebel 
application:

■ Projects screen. As practice or project managers, end users can view and manage 
their projects from this screen.

■ Opportunities screen. As sales representatives, end users may want to create a 
project and fill in the preliminary information as it associates with the 
opportunity.

■ Accounts screen. As account managers, end users may want to monitor projects 
at the account level. 

The following procedure explains how to create a project using the Projects screen. 
End users can use similar steps to create projects in either the Opportunities screen 
or the Accounts screen.

To create a new project using the Projects screen

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, add a new record.
Version 7.5, Rev. A Siebel Professional Services Automation Guide 49



Project Management

Creating Projects
4 Complete the necessary fields. Some fields are described in the following table. 

Field Comments

Account Account associated with the project. This could be a 
customer account for a customer project or an internal 
account for an internal project. If you associate an 
opportunity with this project, the Account field is 
automatically populated with information from the 
chosen opportunity.

Delivery Indicates the probability of delivering the project on time, 
according to your organization’s criteria. In the Projects 
list, this field is read-only. You can change the value of this 
field in the Projects More Info form. By default, available 
values are Green, Yellow, and Red. Available values are set 
using the PROJECT_DLVRY_STATUS list of values. 
Defaults to Green. 

End Estimated end date for the project.

Name A name of your own choosing to identify the project. 
Required.

New An asterisk in this field indicates that the current user has 
been assigned to the project, and has not yet reviewed 
project details.

Priority Flag A visual indicator that can be used to designate high-
priority projects. Each user’s priority flag settings are 
visible only to that user.

Project # Identification code for the project. Automatically 
populated with a unique value generated by the Siebel 
application. If you prefer, you can substitute your own 
unique project identification code.

Start Start date for the project.

Status Indicates the current state of the project. By default, 
available values are Active, Cancelled, Closed, Inactive, 
and Not Yet Active. Defaults to Not Yet Active. Available 
values are set in the PROJECT_STATUS list of values.

Access List Lists the User IDs of people who are authorized to view or 
modify project information, depending on the value of the 
accompanying Access Type field. Automatically populated 
with User ID of project creator. For more information 
about access to project information, see “Providing Access 
to a Project” on page 56.
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Access Type Determines whether users must be listed in the project 
access list to view or modify project information. 
Available values are as follows:

■ Private. Only users who are specified on the project 
access list can view and modify project information.

■ Public. Each member of your organization can view 
and modify project information.

■ Public Read Only. Each member of your organization 
can view project information, but only those who are 
specified on the access list can modify information.

Address If you specify a value for Account in the More Info form, 
the Address field is automatically populated with 
information from the chosen account.

Bill Type Indicates how the project will be billed. By default, 
available values are Fixed Fee, Time & Materials, % of 
Fees, Non-Billable, and Event Billed. Available values are 
set in the PROJ_BILLING_TYPE list of values.

City City in which the account associated with the project is 
located. If you specify a value for Account in the More Info 
form, the City field is automatically populated with 
information from the chosen account.

Class Indicates the general nature of the selected project. By 
default, available values are Client Billable, Client 
Investment, Holiday, Internal, Sick Time, Training, and 
Vacation. Defaults to Client Billable. Available values are 
set in the PROJECT_CLASS list of values.

Cost List Specifies the cost list associated with the selected project. 
The cost list specifies internal costs for specific products, 
including service products such as consulting services. 
This field is automatically populated based on the value 
you choose for Rate List. 

For more information about setting up cost lists, see 
“Overview of Rate List and Cost List Management 
(Administrator)” on page 34 and “Creating a Cost List 
(Administrator)” on page 44.

Country Country in which the account associated with the project 
is located. If you specify a value for Account in the More 
Info form, the Country field is automatically populated 
with information from the chosen account.

Field Comments
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Created Date the project record was created. Automatically 
populated.

Currency Monetary unit associated with the selected project. 
Defaults to the currency of the project creator’s 
organization.

Day Limit Maximum number of days that can be charged.

Division Part of the organization responsible for the project.

Duration Format Units in which project time is tracked. Default values are 
Minutes, Hours, Days, Weeks, and Months. This is 
particularly important for Microsoft Project integration to 
define the units that will be exchanged.

Expense Limit Maximum expenses that will be billed to the customer.

Fee Limit Maximum amount of money to be charged for the project. 
Can be used as a trigger for financial notifications 
implemented using a specially configured workflow or 
state model, such as notification when the total amount 
billed for the project reaches 90% of the fee limit value.

Hour Limit Maximum number of hours billed to the customer.

Marketing Program Associate a campaign to the project.

Opportunity Sales opportunity associated with the project. If an 
opportunity is associated with a project, a number of 
fields autopopulate based on the opportunity’s 
information. For example, Account.

Organization Organization or organizations within your company that 
are responsible for the project. Defaults to the 
organization of the project creator. This allows you to 
share projects with partners.

Parent Project Indicates the larger project of which the current project is 
a part, if such a relationship exists.

Project News Specifies any preexisting news feeds to display on Project 
Center or Project Summary pages. For information about 
setting up news feeds, see Siebel Employee Relationship 
Management Administration Guide.

Field Comments
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Project Summary Graphic Specifies a graphic to display on the Project Summary 
page. Available values are project attachments. The 
application attempts to display the attachment that has 
the Primary check box selected. For information about 
adding attachments to projects, see “Attaching a File to a 
Project” on page 78.

Project Type Indicates the general nature of the project. Typical values 
include Infrastructure, Applications Development, 
Business Development, Deployment and Implementation, 
Internal Projects, Pro Bono, and so on. Values come from 
the PROJECT_TYPE LOV.

Rate List Specifies the rate list associated with the selected project. 
The rate list specifies what you charge for specific 
products, including service products such as consulting 
services. When you specify a rate list for a project, the cost 
list associated with that rate list is automatically 
associated with the project as well. For more information 
about setting up rate lists, see “Overview of Rate List and 
Cost List Management (Administrator)” on page 34 and 
“Creating a Rate List (Administrator)” on page 46.

Related Links One or more Web sites or other hyperlinks associated with 
the current project. These links are not active in the 
Projects More Info form, but are active in the Related 
Links section of the Project Summary page.

Related Projects Projects related to the current project. For example, if the 
current project is similar to another project that was 
completed recently, you may want to refer to the 
completed project for reference purposes. Note that access 
to related projects follows regular security rules: a user 
must be granted access to a nonpublic project to view 
information about it.

Revenue Estimated currency amount the project will earn. The 
value in this field is not calculated from other fields.

Site Site in which the account associated with the project is 
located. If you specify a value for Account in the More Info 
form, the Site field is automatically populated with 
information from the chosen account.

Field Comments
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NOTE: Beginning with Siebel 7, end users can edit the Project # field. By default, this 
field is automatically populated with a unique project number generated by the 
Siebel application. However, end users have the flexibility to substitute their own 
project identification numbers in this field.

Source Specific event or other source that provided the sales lead 
that led to the current project.

Source Type Type of event or other source that provided the sales lead 
that led to the current project. Automatically populated 
based on the value you choose for the Source field.

State State in which the account associated with the project is 
located. If you specify a value for Account in the More Info 
form, the State field is automatically populated with 
information from the chosen account.

Zip Code Postal code for the account associated with the project. If 
you specify a value for Account in the More Info form, the 
Zip Code field is automatically populated with 
information from the chosen account.

Field Comments
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Associating Contacts with a Project
When end users create a project, they normally specify an account that is associated 
with that project. End users can also associate one or more individual contacts with 
a project. The following procedure explains how to associate a contact with a 
project.

To associate a contact with a project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the contact will be associated, 
and then click either the Name hyperlink for that project or the Contacts view 
tab.

4 In the Contacts list, click New.

5 In the Add Contacts dialog box that appears, select the contact or contacts you 
want to add and then click OK.

NOTE: If you want to select multiple contacts, hold down the CTRL key while you 
select the records.

The Add Contacts dialog box closes, and the record or records you selected 
appear in the Contacts list. 
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This version of Siebel Professional Services Automation lets end users specify one 
of three different levels of access to information for each project. The access level 
for a Project is set in the Access Type field of the Projects More Info form. Available 
values are as follows:

■ Private. Only users who are specified on the project access list can view and 
modify project information.

■ Public. Each member of the organization can view and modify project 
information.

■ Public Read Only. Each member of the organization can view project information, 
but only those who are specified on the access list can modify information.

By default, the creator of a project is automatically added to the access list as the 
Primary member of the list. It is required that a project access list always have one 
Primary member. The Primary designation can be moved from one user to another, 
but any user who currently holds the Primary designation cannot be removed from 
the access list.

To have any user except the project creator be able to view and modify information 
on a Private project, or to have any user except the project creator to be able to 
modify information on a Public Read Only project, end users can add that person’s 
user ID to the project access list. The following procedure explains how to do this. 

To grant access to a project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project to which the access will be granted.

4 Click the Access view tab.

5 In the Access list, click New.

6 In the Add Employees dialog box that appears, select the employee or employees 
who should have access to this project and then click OK.
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Creating Activities Using Activity Plans
Activity plans provide a set of prebuilt best practice templates that create a 
collection of activities in a logical order based on the start date specified. The 
following procedure explains how to create activities using activity plans.

To create activities using activity plans

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the activities will be associated.

4 Click the Activity Plans view tab.

5 In the Activity Plans list, add a new record.

6 Select an activity plan template from the Template drop-down list.

The activities associated with the activity plan appear in the Activities list 
subview. For information about creating activity plans, see Siebel Applications 
Administration Guide. For more information about using activity plans, see 
Siebel Call Center User Guide.
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Creating Project Activities Manually
End users can also create activities without the aid of activity plans. The following 
procedure explains how to create activities from the Activities view tab in the 
Projects screen. Activities created in Tasks and Risks will also be visible in the 
Activities view in the Projects screen. For more information, see “Adding Activities 
to a Task” on page 62 and “Creating Risk Resolution Activities” on page 74.

To create activities for a project manually

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the activities will be associated.

4 Click the Activities view tab.
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5 In the Activities list, add a new record.

6 Complete the necessary fields. Some fields are described in the following table.

Field Comments

Start Date and time when the activity should start.

Type General category of the activity. Defaults to a hyperlink with the value 
of Appointment. Clicking the hyperlink displays the Attachments view 
of the Activities screen, where the value of Type can be changed and 
additional activity characteristics can be specified. 

Description Brief note describing the activity. 

Due Date and time by which the activity should be completed. 

Status Current status of the activity. 

Priority Importance of the activity. 

Employees One or more employees assigned to finish the activity. Defaults to the 
User ID of the activity creator. This field is not displayed by default in 
the Service Activities view, but it can be displayed through the use of the 
Columns Displayed command or by clicking the Type hyperlink to 
navigate to the Activities screen. 

Display In Determines whether the activity is displayed in the Activity screen, in 
the Activity screen and the Calendar screen, or in the Activity screen and 
the To Do list. An activity cannot appear in both the Calendar and the 
To Do list. Defaults to Calendar and Activities. 

Alarm Check this box to turn on a reminder alarm for this activity.

Alarm Lead The Alarm Lead field is automatically populated with the default alarm 
lead time. You can change this value from the User Preferences screen; 
you can also manually override it for each activity, by entering a new 
value in this field. 
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End users can use tasks to group activities together logically. Tasks function as 
containers for groups of related activities. In this version of Siebel Professional 
Services Automation, tasks can be imported from Microsoft Project into Siebel 
Professional Services Automation, and can be exported from Siebel Professional 
Services Automation to Microsoft Project. For more information about using 
Microsoft Project with Siebel Professional Services Automation, see Chapter 5, 
“Microsoft Project Integration.” There are two parts to creating and using a task: 
creating the task record, and then adding new activities to the task.

To create tasks 

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the tasks will be associated.

4 Click the Tasks view tab.
60 Siebel Professional Services Automation Guide Version 7.5, Rev. A



Project Management

Creating Tasks
5 In the Tasks list, add a new record.

6 Complete the necessary fields. Some fields are described in the following table.

Field Comments

Description Brief note describing the task.

Do Not Export Check this box if you do not want this task to be exported to 
Microsoft Project.

Due Date and time the task should be finished.

Name Name given to the task. If no name is given you will be unable to 
drill down on the task to add further details or add activities to the 
task.

Parent Task Allows for hierarchy of tasks. For example, one task might be 
Deploy System while a child might be Training.

Predecessor Task Task that needs to be completed before this one can be started.

Priority Importance of the task.

Status Current status of the task.

Type A way of defining what type of task this is. For example, Milestone 
or Meeting.
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Adding Activities to a Task
Once a task is created, activities can be added to it.

To add an activity to a task

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the tasks are associated.

4 Click the Tasks view tab. 

5 In the Tasks list, click the Name hyperlink for the task you want to add an 
activity to.

The Tasks form appears with the Activities list view beneath it.

6 In the Activities list, add a new record.

7 Complete the necessary fields. For description of the fields available see 
“Creating Project Activities Manually” on page 58.
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Viewing Tasks
If an end user imports Microsoft Project files to create tasks and they import 
successfully, end users can use the following procedure to view the tasks.

To view tasks

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the tasks are associated.

4 Click the Tasks view tab.

A listing of the tasks appears.

NOTE: Drilling down on a task takes you to a Tasks form. Beneath the Tasks form 
is an Activities view and an Attachments view.
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Using the Team Workbook
As part of the process of creating a project, a project manager identifies the roles 
that need to be filled on the project team, and the approximate start and end date 
for each role. The Team Workbook helps managers track project cost and rate 
structures, submit resource requests, and manage overall resource needs of the 
project. An example of the Team Workbook view is shown in Figure 2 on page 64.

Overview of Project Staffing
End users outline project resource needs and requests by using the Team Workbook. 
The most common process is as follows:

1 Set project rates and cost schedules.

2 Estimate resource needs.

3 Identify the following project requirements:

■ Resource start and end dates.

■ Skills and competencies.

■ Project roles.

4 Submit your resource requests to your organization’s resource manager.

5 Perform project resource management tasks such as using parent positions to 
establish project team relationships.

Figure 2. Team Workbook View
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Setting Up Roles in a Project Team Workbook
The Team Workbook maintains resource information for the project. It identifies 
required roles, skills and competencies associated with those roles, and time 
commitments. For information about creating roles, see “Creating Roles 
(Administrator)” on page 37.

To identify roles for the team workbook

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the Team Workbook will be 
associated.

4 Click the Team Workbook view tab.

5 In the Team Workbook list, add a new record.
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6 Complete the necessary fields. Some fields are described in the following table.

Field Comments

Assignment Status This field represents the status of the assignment to a user. For 
example, Requested is intended to mean that a resource has 
not been definitely booked on a project, where Assigned is 
booked. In addition, the Assignment Status field is taken into 
account when determining the availability percentage on the 
Resource Requests screen Availability button. Assigned and 
Full Time assignments are given more weight than Requested 
and Part Time on the percentage that displays on the Potential 
Resources view. Defaults to Requested-Full Time.

Cost Cost defaults based on a number of factors. For details on 
these factors, see “Overview of Rate List and Cost List 
Management (Administrator)” on page 34.

Rate Rate is set by the resource type that you choose from a 
designated rate list that has been created by the administrator. 
Rate is defaulted but can be overridden if necessary.

Resource Resources drive the rate, and resources can fill multiple roles 
on a project.

Role A role represents the job that this team member will be 
working on this project. For example, Project Manager. A role 
is different from a title in that a role is project based. You can 
be one role on one project and an entirely different role on 
another.

User ID User ID of the resource selected to fill this role.

Last Name Last Name of the resource selected to fill this role.

First Name First Name of the resource selected to fill this role.

Start Start date of role.

End End date of role.

Effective Rate The Effective Rate field refers to the actual rate charged to the 
customer. The Effective Rate is equal to Rate factored by the 
discount.

Total Estimated Hours Number of days on the project multiplied by 8 hours per day.
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NOTE: Repeat Step 5 on page 65 and Step 6 on page 66 until you have added 
every role.

Total Rate Is equal to the Total Estimated Hours multiplied by the 
Effective Rate.

Nickname Identifier for the person being assigned to the specified team 
role. When a new team workbook record is created, the value 
of this field defaults to a unique row ID number. When a value 
is entered for the User ID field, the value in the Nickname field 
automatically changes to the User ID value. If the person you 
specify will be listed more than once in the current project’s 
team workbook, you must modify the value in the Nickname 
field to provide a unique value for each team workbook record 
in the project. The Nickname field maps to the Microsoft 
Resource Name field.

Field Comments
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Associating Skills and Competencies with Team 
Workbook Roles

After adding a role to the Team Workbook, end users will want to associate skills 
and competencies with that role. These skills will be forwarded to the Resource 
Manager. This is also an good way to assign people and populate their positions 
through the Team Workbook. For more information about setting up skills, see 
Siebel Assignment Manager Administration Guide.

To add skills and competencies

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the Team Workbook will be 
associated. 

4 Click the Team Workbook view tab.

5 In the Team Workbook list, select the role to which the skills will be added.

6 In the Skills subview list, add a new record.

7 In the new record, select a skill from the Skill drop-down list.

8 In the Competencies subview list, add a new record.

9 In the new record, enter the appropriate information.

The fields available are specific to the skill selected in the Skills list. Some fields 
are described in the following table.

NOTE: Repeat Step 5 through Step 7 for each new skill. Repeat Step 8 through 
Step 9 for each new competency.

Field Comments

Expertise Determine the level of expertise this skill requires. Default choices are 
Novice, Intermediate, and Expert.

Importance Determine how important is it that the person filling this role has this 
skill. Default choices are Critical, Important, and Nice to Have.
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Rates are set for project staff from the Team Workbook’s Resource Detail view. Rates 
set here for a user become the hourly rate on that user’s time sheet. When users 
create new time sheet line items in a time sheet and add a project and a project role, 
the hourly rate field is populated with the resource rate defined in the Team 
Workbook’s Resource Detail view. For more information about time sheet line 
items, see “Adding Line Items to a Time Sheet” on page 142.

To set hourly rates for a team member

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project for which you want to set staff rates.

4 Click the Team Workbook view tab.

5 In the Team Workbook list, select the role for which you want to set the rate.

6 Choose Resource Detail from the Team Workbook drop-down list.

7 If there is a rate list associated with the project, complete the following substeps:

a In the Resource field, select the resource level appropriate for the project role.

NOTE: Some of the resources listed in the drop-down list may not be set up in 
the project’s rate list. You may need to ask your administrator for information 
about which resources appear in the project’s rate list.

When the resource is selected, the Rate field is automatically updated 
according to the rate list. For more information about rate lists, see “Creating 
a Rate List (Administrator)” on page 46.

b (Optional) In the Discount field, specify a discount for rate.
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8 If there is no rate list associated with the project, complete the following 
substeps:

a In the Rate field, enter an hourly rate for the team member.

b (Optional) In the Discount field, specify a discount for rate.

9 Complete other fields as needed. Some fields are described in the following 
table:

NOTE: In order for rates to appear, the Resource field accessible from My
Projects >Team Workbook >Resource Detail needs to be set for each team 
member. 

Field Comments

Billing Coordinator The employee responsible for managing billings and 
invoicing on the current project.

Cost Cost defaults based on a number of factors. For details on 
these factors, see “Overview of Rate List and Cost List 
Management (Administrator)” on page 34.

Estimated Hours/Day Defaults to 8 hours per day. 

Estimated Work Days Defaults to the number of working days between the role’s 
start and end dates.

Total Estimated Hours Value comes from Estimated Hours/Day multiplied by 
Estimated Work Days.

Total Cost Is equal to Total Estimated Hours multiplied by Cost.
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Adding Subcontractor Information
End users can associate subcontractors with a project, as well as make them 
available as part of a project team. Before associating a subcontractor resource with 
a project, their information must be added to Siebel Professional Services 
Automation. Subcontractors are accounts set up in the Siebel application.

To add subcontractor information

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the subcontractor will be 
associated.

4 Click the Subcontractors view tab.

5 In the Subcontractors list, add a new record.

6 In the Account Name field, click the select button to display the Pick Account 
dialog box.

7 In the Pick Account dialog box, select the subcontractor account and then click 
OK.

NOTE: If the subcontractor account does not exist, click New to create a new 
account.

Subcontractor account information appears in various fields.
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Associating a Subcontractor Resource with a Project
After adding a subcontractor to Siebel Professional Services Automation, end users 
can associate resources from that company to the project. Any subcontractor 
resources associated with a project using the following procedure automatically 
appear in the Team Workbook.

To associate a subcontractor resource with a project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the subcontractor will be 
associated.

4 Click the Subcontractors view tab.

5 In the Subcontractors list, click the Account Name hyperlink for the 
subcontractor.

A Project Subcontractor form appears, with the Resources list below it.

6 In the Resources list, add a new record. 

The records available are employees that have been associated with this 
subcontractor account.

7 In the Role field, select a role from the drop-down list.

8 Complete any other necessary fields. For a description of the fields available, see 
“Setting Up Roles in a Project Team Workbook” on page 65.

NOTE: To create subcontractor agreements and invoices, see Chapter 8, 
“Agreements.”

NOTE: To view the subcontractor details in a form, choose Employee Details from 
the drop-down list in the Resources view. To go back to list format, choose 
Employees from the drop-down list.
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Assessing and Adding Risks to a Project
One of the biggest project management challenges end users face is identifying and 
managing risk items. End users can identify and quantify risk items early in the 
opportunity phase. This has several advantages, it allows for the calculation of the 
appropriate risk premium or discounts, and it gives all parties involved a clear 
understanding of the risks involved.

NOTE: Each risk item can be tracked and reported in the status report.

To create a risk 

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the risk will be associated. 

4 Click the Risks view tab.

5 In the Risks list, add a new record.

6 Complete the necessary fields. Some fields are described in the following table.

Field Comments

Line # Identifies the line number of the risk. The number can be modified.

Type Identifies the kind of risk being described. Examples could include 
customer relationship, low quality, or high turnover.

Name Name given to the risk. If no name is given you will be unable to drill 
down on the risk to add further details or add risk resolution activities.

Reported Date the risk was added to the project.

Priority Importance of the risk.

Status Current status of the risk.

Severity Seriousness of the risk on a scale of 1 to 5.

Description Text of your own choosing explaining further details about the risk.
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Creating Risk Resolution Activities
Risk resolution activities are activities created to address and resolve project risks. 
Risk resolution activities that are created with the following procedure are also 
visible in the Projects Activities view.

To create risk resolution activities

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the risks will be associated.

4 Click the Risks view tab.

5 In the Risks list, click the Name hyperlink for the risk for which you want to 
associate resolution activities.

The Risks form appears with the Resolution Activities list beneath it.

6 In the Resolution Activities list, add a new record.

7 Complete the necessary fields. For information about the fields available, see 
“Creating Project Activities Manually” on page 58.
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Creating a Status Report for a Project
End users may want to create a project status report summarizing the project’s 
progress, forecast, and issues. End users can incorporate any project risk issues into 
the status report. The following procedure explains how to create a status report.

To create a status report

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project for which you want a status report.

4 Click the Status Report view tab.
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5 In the Status Report list, add a new record.

6 In the new record, complete the necessary fields. Some fields are described in 
the following table.

Field Comments

Status Current status of the project. Choose from Green, Yellow, and 
Red.

Stage What stage is the project in. For example, Implementation or 
Validation.

Forecast Finish Finish date projected by current schedule or by project 
manager.

Forecast Cost Cost projected by current schedule or by project manager.

Forecast Fee Overrun The amount a project is forecast to run over the fee limit. The 
value is equal to Forecast Cost minus Fee Limit.

Forecast Overrun Days The number of days the project is forecast to run over the 
targeted project end date. The value is equal to Forecast 
Finish minus Project End Date.

Plan Variance Amount the project is forecast to run over the initial projected 
cost. The value is equal to Forecast Cost minus Planned Total 
Cost.

Planned Total Cost Cost based on initial project schedule.

Reporting Status Status of the current report. For example, In Progress, On 
Hold, or Done.

Fee Limit Maximum amount of money to be charged for the project. 
The value comes from the Fee Limit field in the project 
record.
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Associating Risks with a Status Report
End users can associate risks with a project’s status report. This can enhance the 
status report by letting others know exactly what issues are currently affecting the 
project.

To associate risks with a status report

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project for which you want a status report that 
incorporates risks.

4 Click the Status Report view tab.

5 Select the status report with which the issue will be associated.

6 In the Project Status Item subview list, add a new record.

7 In the Issues field of the new record, click the select button to display the Pick 
Risk dialog box.

8 In the Pick Risk dialog box, select a risk and then click OK, or use the following 
substeps to create a new risk that will also be visible in the Project Risks view:

a In the Pick Risk dialog box, click New to display a Pick Risk form.

b Complete the fields in the form, and then click Save to return to the Pick Risk 
list.

c In the Pick Risk list, make sure the new risk is highlighted, and then click OK.

9 Complete any other necessary fields in the new record.

NOTE: Repeat Step 6 through Step 9 until you have added every risk item. 
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Attaching a File to a Project
End users can store files as attachments to a project. For information on adding 
attachments, see Fundamentals.

Adding a Note to a Project
End users can add both public and private notes to a project. Notes allow for the 
sharing of information among project teams. They can also act as a personal journal 
for a project. Private notes can only be viewed by the users who created them. End 
users can also create a hierarchy of notes, somewhat like a discussion group using 
the Parent Note field.

To add a public or private note

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the note will be associated.

4 Click the Notes view tab.

5 From the Show drop-down list in the Notes view, choose Public Notes or Private 
Notes.

6 In the Note Detail form, add a new record. 

7 Complete the fields.

Field Comments

Parent Note A hierarchy of notes can be created, somewhat like a discussion group. 
One note could be a response to or related to another note, and thus 
would be a child. The other note would be a parent note.

Type Type of note being created.
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Creating an Order for Project Materials
End users may want to create a product or material order and associate it with a 
project. This functionality allows for the tracking of material costs related to a 
project.

To create an order

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the order will be associated.

4 Click the Orders view tab.

5 In the Orders list, add a new record.

6 Complete the necessary fields. Some fields are described in the following table.

7 Click the Order # hyperlink to display the Orders screen and add additional 
details concerning the order.

Field Comments

Account Account associated with the project. Automatically filled in when you 
create an order from a project record associated with an account.

Active Check box specifying whether the order is currently active. If it is active, 
the box is checked, if it is not active, the box is not checked.

Order # Number created automatically by the Siebel application to identify this 
order.

Order Date Date on which the order was created. Defaults to the current date and 
time. This value can be changed as needed.

Project Project for which this order is being created. Automatically filled in when 
you create an order from a project record.

State State of the order. Choices may include open, closed, or pending. Note 
that this may not be the same as status.

Status Current status of the order. 

Type The kind of order being created. Examples could include a purchase order 
or a sales order.
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Changing the Delivery Status of a Project
If a project’s delivery status changes during the course of the project, end users will 
want to update its status. This provides team members and managers with updated 
information. Delivery status can be updated from the Project More Info view.

To change the delivery status of a project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project that needs to be updated.

4 Click the More Info view tab.

5 In the More Info form, from the Delivery drop-down list, select the new status 
of the project: Red, Yellow, or Green.

The results of this change appear in the Projects list in the Delivery field.

NOTE: Delivery status can also be changed from the Financial Profile view in the 
Projects screen. The Financial Profile view includes a summary of the project.
80 Siebel Professional Services Automation Guide Version 7.5, Rev. A



Project Management

Using the Project Center and the Project Summary View
Using the Project Center and the Project Summary View
The Project Center view provides users with an overview of their projects, 
highlighting key project information. The Project Summary view provides users 
with a summary of a particular project’s key information. For more information, see 
Siebel Employee Relationship Management Administration Guide.
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This chapter describes resource management functionality, and provides a business 
scenario and end-user procedures.

Resource management is designed to manage the process of staffing resources for 
project assignments. Practice managers, engagement managers, and project 
managers identify required resources for a project and create records in the Team 
Workbook view. These records also serve as resource requests. Resource managers 
process these requests by reviewing them and searching for the best resources to fill 
them based on skills and availability. Resource managers can directly assign a 
resource to fill the request, or they can provide candidates for consideration.
Version 7.5, Rev. A Siebel Professional Services Automation Guide 83



Resource Management

Business Scenario for Resource Management
Business Scenario for Resource Management
This scenario provides an example of a process performed by a resource manager. 
Your company may follow a different process according to its business 
requirements.

The resource manager at a large consulting company uses his Siebel application to 
fill resource requests for project managers and to staff projects. As the resource 
manager navigates to the Resource Requests screen, Unassigned Resource Requests 
view, he sees there are several new requests to be filled. He can see a need for three 
resources that are unfilled, each of which has specific skills required to meet the 
staffing requirements. Looking at the developer role, he can see that the qualified 
individual must have expert skills in Microsoft Visual Studio and have intermediate 
skills in Windows 2000. Not only are the product skills important, but the qualified 
resource must also be able to speak Japanese. The project manager entered these 
necessary skills for each role in the Team Workbook for the project.

The resource manager can choose the developer role, and search for qualified 
employees. First, he specifies the acceptable minimum skill and availability scores 
he wants to use in the resource search. After supplying the criteria and getting the 
results, he is given the number of resources that match the skills criteria and the 
number of resources available to fill the project role.

After the resource manager has found people with the appropriate skills, he 
navigates to the Potential Resources view where he sees a list of candidates. He 
sorts the list by Availability score. To make sure the resources are available during 
the desired time frame, he checks the Resources Availability view which shows a 
Gantt chart of each potential resource’s availability. After verifying that the resource 
is available, he clicks the menu button and selects Add to Project Team and the 
resource appears in the Team Workbook view.

The resource manager can also check the Notes view to see any additional 
information, such as client special requests.
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Example Process for Resource Management
This is an example of a process performed by end users for resource management. 
Your company may follow a different process according to its business 
requirements.

1 Use the Resource Requests screen. For information, see “Using the Resource 
Requests Screen” on page 86.

2 Review resource requests. For information, see “Reviewing Resource Requests” 
on page 87.

3 Assign ownership of a resource request. For information, see “Assigning Ownership 
of Resource Requests” on page 88.

4 Search for a potential resource. For information, see “Searching for Potential 
Resources” on page 89.

5 Use candidate history to track candidates. For information, see “Using Candidate 
History to Track Candidates” on page 90.

6 Assign a resource to a project. For information, see “Assigning Resources to a 
Project” on page 91.
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Using the Resource Requests Screen
The Resource Requests screen is organized to help users maximize their 
productivity. It provides the following filtered views of the Resource Requests list 
(these filters can be accessed by using the Show drop-down list):

■ Unassigned Resource Requests. Shows the resource requests where the Owner 
field is currently blank.

■ My Resource Requests. Shows the resource requests where the Owner field is 
equal to the current user.

■ My Submitted Resource Requests. Shows the resource requests where the 
Requested By field is equal to the current user.

■ All Resource Requests. Shows an unfiltered resource request list.

NOTE: Any of these views can be used in the procedures that follow. 
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Reviewing Resource Requests
Before filling any requests for resources, the resource manager must review each 
resource request to make sure he knows what the requestor is looking for. Careful 
examination of the details in the More Info view, the Notes view, and in the Skills 
view can provide the resource manager with the information he needs to fill 
resource requests.

To review resource requests

1 Navigate to the Resource Requests screen.

2 In the Resource Requests list, select the resource request you want to review.

3 Click the More Info view tab to see each of the resource request record’s fields.

4 Click the Notes view tab to see any notes written about this resource request.

5 Click the Assignment Skills tab to see the skills and competencies attributed to 
this resource request.
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Assigning Ownership of Resource Requests
The Unassigned Resource Requests view is used to monitor resource requests that 
are not currently assigned to a resource manager. Resource requests can be assigned 
by selecting a user in the Owner field.

To assign ownership of a resource request

1 Navigate to the Resource Requests screen.

2 From the Show drop-down list, select Unassigned Resource Requests.

3 In the Resource Requests list, select a resource request.

4 In the More Info form below the Resource Requests list, click the show more 
button.

5 In the Owner field, click the select button.

6 In the Pick Position dialog box, select the owner and click OK.

NOTE: If the value of the Owner field is set to your user name, the resource 
request is displayed in the My Resource Requests view rather than the 
Unassigned Resource Requests view.
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Searching for Potential Resources
The following procedure explains how to search for resources.

To search for resources 

1 Navigate to the Resource Requests screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Resource Requests list, select a resource request to be processed.

4 In the More Info form, click Find Resources.

A skills search is performed. Resources meeting the skills and competencies 
defined on the role appear in the Potential Resources view.

5 Click the Potential Resources view tab.

6 (Optional) Click the menu button, and then click Calc. Availability.

This calculates availability for resources returned.

7 (Optional) In the More Info form, fill in the Skill Min Score and Availability Min 
Score fields.

8 (Optional) Click the menu button, and then click Apply Min Score.

This applies the filters entered in Step 7 to the Potential Resources view. The 
Skill # Found and Availability # Found fields are populated with the number of 
qualified candidates. The Skill filter is applied first followed by the Availability 
Filter. Therefore, the Availability filter is applied to the resources left after the 
Skill filter is applied. The resulting list of resources are the resources which 
exceed both minimum scores.

9 Click the Resources Availability view tab.

This displays a graphical representation of the candidate’s availability. In this 
Gantt chart, you can only show four concurrent assignments per person.

NOTE: In the Gantt chart, using the cursor hover over each colored bar to view 
project assignment details. Different colors are used to represent different 
assignment statuses in the Gantt chart. 
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Using Candidate History to Track Candidates
The Candidate History view is used to keep track of employees who are possible 
candidates for filling the resource request.

NOTE: The Candidate History view is static, unlike the Potential Resources view 
which is dynamic and refreshes each time the Find Resources button is clicked.

End users can track the status and disposition of each candidate in the list; thus, the 
Candidate History view maintains a record of candidates who were considered for 
this role.

To add an employee to the candidate history

1 Navigate to the Resource Requests screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Resource Requests list, select the request with which you are working.

4 Click the Candidate History view tab.

5 In the Candidate History list, add a new record.

6 Complete the necessary fields.

NOTE: Status and Disposition are not required fields, but you can use them to 
track each candidate’s history on the resource request.
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Assigning Resources to a Project
Once an individual’s availability has been reviewed and it has been determined that 
the individual meets the needs of the project, the individual can be assigned to the 
project as a resource.

To assign a resource to a project

1 Navigate to the Resource Requests screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Resource Requests list, locate the request you are working on.

4 Click the Potential Resources tab.

5 In the Potential Resources list, select the individual you want to assign to the 
project, click the menu button and then click Add to Project Team.

The individual now appears in the User ID field, the Last Name field, and the 
First Name field, as well as the Team Workbook in the associated project.

NOTE: End users can also directly assign a resource to a role by populating the 
User ID field in the Team Workbook or the Resource Requests screen.
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This chapter explains how to administer and use the integration functionality that 
lets you move information between Siebel Professional Services Automation and 
Microsoft Project.

While working on a project, you may want to exchange information between your 
Siebel application and Microsoft Project. Information can flow from Microsoft 
Project to your Siebel application and from your Siebel application to Microsoft 
Project. The information exchange can be repeated as many times as necessary 
during a project.

In Microsoft Project, project managers can define relationships among project tasks, 
and can see how the overall schedule is affected by progress or delays on individual 
tasks and by availability of specific resources. 

In your Siebel application, project team members can record hours worked, project-
related expenses, and progress on their assigned project tasks. Project managers can 
see cumulative totals for time and money spent on particular projects and can 
monitor progress on project tasks. Business rules within your Siebel application 
prevent deletion of project tasks that have billable costs. Business rules can also be 
used to create projects automatically, when sales opportunities reach a designated 
stage.
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Typically, a project is created in Microsoft Project, and project data is imported into 
the Siebel application for resource assignment or time and expense tracking. Project 
data can be exported from the Siebel application to Microsoft Project after resource 
assignments have been made, after various project tasks have been completed, and 
after time and expense entries have been collected. The updated information allows 
Microsoft Project to display how decisions and progress affect the overall project 
schedule.

NOTE: Before you use the procedures in this chapter with the Siebel Web Client, be 
sure that your Siebel Document Server is set up and Microsoft Project is installed. 
You do not need the Siebel Document Server if you are using the Siebel Mobile Web 
Client. For information about setting up the Siebel Document Server, see Siebel 
Applications Administration Guide. 
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Business Scenario for Microsoft Project Integration
This scenario provides an example of a process performed by a Siebel administrator, 
a project manager, and a consultant. Your company may follow a different process 
according to its business requirements. 

A Siebel administrator at a large consulting company is responsible for setting up 
Microsoft Project integration capabilities. He should understand what mapping 
templates are, how they work, and how they are created. With this knowledge, he 
creates and modifies mapping templates as needed for Microsoft Project integration.

The company’s project manager manages projects using Microsoft Project and 
Siebel Professional Services Automation. For new projects, she creates a new project 
in Siebel Professional Services Automation and completes relevant project 
information such as project start date and end date, expected revenue, fees and 
expense limits, access list, attachments, billing information, contact list, and notes. 
Once the project framework has been completed, she can create the project scope 
using Microsoft Project.

To create a project scope, the project manager uses an existing Microsoft Project file 
or template. During this process, she identifies the project structure (dependencies, 
hierarchies, and schedule constraints), work breakdown structure (WBS), expected 
roles, and budget information. After completing the project scope, she imports the 
project into Siebel Professional Services Automation. 

In Siebel Professional Services Automation, the project manager focuses on 
resource analysis, such as defining the roles that she needs for this project in the 
Team Workbook. She incorporates the roles already identified in Microsoft Project 
and can specify additional roles in Siebel Professional Services Automation. She 
submits her requirements to the resource manager, who makes staffing 
assignments. After the resource manager completes the initial staffing, the project 
manager exports the resource information to her existing Microsoft Project file for 
task-level delegation and planning. She then views the log file generated by this 
export, and saves it for later use.
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Back in Microsoft Project, the project manager reviews the list of resources that have 
been assigned to the project. These are designated by their User IDs and roles. By 
default, Microsoft Project automatically updates the project schedule. The project 
manager may make additional updates manually. Once she completes the review 
and update process, she reimports the project file into Siebel Professional Services 
Automation, to update tasks with any schedule changes automatically. 

In Siebel Professional Services Automation, the project manager reviews time and 
expenses submitted for the project and makes adjustments where needed. She also 
updates the project to reflect the percentage of the project that is complete. Once 
she finishes the update, she exports the updated information on tasks, resources, 
percentage complete, and cost to her existing Microsoft Project file.

Microsoft Project automatically reschedules project tasks to reflect progress to date. 
It also updates any changed resource information such as new assignments. The 
project manager reviews the project and restructures task relationships to include 
any tasks that were newly added in Siebel Professional Services Automation. She 
then decides whether any additional tasks are required for the project and whether 
any existing tasks should be deleted. Afterward, the project manager saves the 
Microsoft Project file and again imports the updated project information into Siebel 
Professional Services Automation.

In Siebel Professional Services Automation, the project data is updated to reflect the 
rescheduling done by Microsoft Project. Any tasks that were added and assigned in 
Microsoft Project are distributed automatically to their assignees. If there are time 
or expense items associated with any task that was deleted or promoted to a 
summary task in Microsoft Project, that information is saved in Siebel Professional 
Services Automation and remains available for time and expense reporting as well 
as invoicing and adjustments. This iterative project management process involving 
importing from and exporting to Microsoft Project continues until the project is 
finished.
96 Siebel Professional Services Automation Guide Version 7.5, Rev. A



Microsoft Project Integration

Example Process for Microsoft Project Integration
Example Process for Microsoft Project Integration
This is an example of a process for revenues. Your company may follow a different 
process according to its business requirements.

Administrator Procedures
The following are administrator procedures for Microsoft Project Integration.

1 Understand mapping templates. For information, see “Understanding Mapping 
Templates (Administrator)” on page 98.

2 Create a mapping template. For information, see “Creating Mapping Templates 
(Administrator)” on page 102.

3 Modify a mapping template. For information, see “Modifying Mapping Templates 
(Administrator)” on page 104.

End-User Procedures
The following are end-user procedures for Microsoft Project Integration.

1 Import information from Microsoft Project into Siebel Professional Services 
Automation. For information, see “Importing Information from Microsoft Project 
into Siebel Professional Services Automation” on page 105.

2 Export information from Siebel Professional Services Automation to a new Microsoft 
Project file. For information, see “Exporting Information from Siebel Professional 
Services Automation to a New Microsoft Project File” on page 107.

3 Export information from Siebel Professional Services Automation to an existing 
Microsoft Project file. For information, see “Exporting Information from Siebel 
Professional Services Automation to an Existing Microsoft Project File” on 
page 109.

4 View a log file. For information, see “Viewing a Log File” on page 110.

5 Save a log file. For information, see “Saving a Log File” on page 111.
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Understanding Mapping Templates (Administrator)
The tasks and resources you define for a project in your Siebel application can be 
exported to and imported from a Microsoft Project .mpp file. To exchange data 
between these two applications, however, you must use a mapping template that 
defines how Siebel fields and Microsoft fields map to each other. 

Siebel Professional Services Automation includes three preconfigured mapping 
templates:

■ Tasks Only. This template maps Microsoft Project tasks and summary tasks to the 
Siebel Projects Tasks view. Resource information is not imported or exported. 
For information about specific mappings in the Tasks Only template, see Table 2 
on page 99.

■ Resources Only. This template maps Microsoft Project resources to the Siebel 
Projects Team Workbook view. Task information is not imported or exported. For 
information about specific mappings in the Resources Only template, see Table 3 
on page 99.

■ Standard. This template is a combination of Tasks Only and Resources Only 
templates. Information about both tasks and resources is imported or exported. 
For information about specific mappings in the Standard template, see Table 4 
on page 100.

If you create or modify a mapping template, you must assign one or more mapping 
categories to the template. Each category indicates the kind of fields that are 
mapped in the template. In the preconfigured templates described in the preceding 
paragraphs, the Tasks Only template is set to use the Tasks category, the Resources 
Only template is set to use the Project Resources category, and the Standard 
template is set to use both the Tasks category and the Project Resources category.
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If necessary, a Siebel administrator can modify these templates or create additional 
templates to meet the needs of your organization. For information about creating or 
modifying mapping templates, see “Creating Mapping Templates (Administrator)” 
on page 102 or “Modifying Mapping Templates (Administrator)” on page 104.

Table 2. Task Only Mapping Template Between Siebel Professional Services 
Automation and Microsoft Project

Siebel Microsoft Import Export Sequence

Actual End Date Actual Finish X X 5

Actual Start Date Actual Start X X 2

Complete Percentage Percent Complete X X

Description Text 2 X X

Duration Hours Duration X X 4

Est Cost Amount Cost X X

Item Alt Type Text 1 X X

Name Name X X

Note Notes X X

Planned End Date Finish X X 3

Planned Start Date Start X X 1

Priority Text 5 X X

Resource Number (Nickname) Resource Names X X

Status Text 3 X X

Table 3. Resources Only Mapping Template Between Siebel Professional Services 
Automation and Microsoft Project

Siebel Microsoft Import Export Sequence

Comments Notes X X

eMail eMail Address X
Version 7.5, Rev. A Siebel Professional Services Automation Guide 99



Microsoft Project Integration

Understanding Mapping Templates (Administrator)
End Date Finish X

Full Name (calculated field based on First 
and Last Name)

Text 1 X

Rate Standard Rate X X

Resource Number (Nickname) Name X X

Role Group X

Start Date Start X

Table 4. Standard Mapping Template Between Siebel Professional Services 
Automation and Microsoft Project

Siebel Microsoft Import Export Sequence

Task Mappings

Actual End Date Actual Finish X X 5

Actual Start Date Actual Start X X 2

Resource Number (Nickname) Resource Names X X

Complete Percentage Percent Complete X X

Description Text 2 X X

Duration Hours Duration X X 4

Est Cost Amount Cost X X

Item Alt Type Text 1 X X

Name Name X X

Note Notes X X

Planned End Date Finish X X 3

Planned Start Date Start X X 1

Table 3. Resources Only Mapping Template Between Siebel Professional Services 
Automation and Microsoft Project

Siebel Microsoft Import Export Sequence
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While you are planning the details of how data will be exchanged between Siebel 
Professional Services Automation and Microsoft Project, be sure to consider the 
following constraints: 

■ List of Values. If a Siebel task or resource field is implemented as a list of values 
(LOV), and if it will receive imported data from Microsoft Project, the list of 
values available for the field must contain the exact values that will be imported, 
with the case matching for each character of the imported value. For example, 
the Priority, Status, and Type fields in Siebel Professional Services Automation 
are implemented as LOVs. For information about modifying LOVs, see Siebel 
Applications Administration Guide.

■ Resources. If resources in Microsoft Project are specified using User IDs, exactly 
the same User IDs must be must be reflected in the Siebel application’s employee 
list, using the same case for each character. 

■ Configuration. Not every field in Microsoft Project can be imported or exported 
without configuration in Siebel Tools.

Priority Text 5 X X

Status Text 3 X X

Resource Mappings

Comments Notes X X

eMail eMail Address X

End Date Finish X

Full Name (calculated field based on 
First and Last Name)

Text 1 X

Rate Standard Rate X X

Resource Number (Nickname) Name X X

Role Group X

Start Date Start X

Table 4. Standard Mapping Template Between Siebel Professional Services 
Automation and Microsoft Project

Siebel Microsoft Import Export Sequence
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Creating Mapping Templates (Administrator)
If your organization needs templates that differ from those provided with Siebel 
Professional Services Automation, you can create them. The following procedure 
explains how to create a mapping template.

NOTE: The Start and Finish columns in Microsoft Project's Resource Sheet are auto-
populated based on resource assignments. Therefore, resource Start Date and End 
Date values from the Siebel Project Team Workbook view cannot be exported to 
Start and Finish columns in a Microsoft Project Resource Sheet. If these two fields 
need to be exported to Microsoft Project, map the Siebel Start Date and End Date 
fields to Start1 and Finish1 fields in Microsoft Project. 

To create a mapping template

1 From the application-level menu, choose View > Site Map > Data 
Administration > Project Mappings.

2 In the Project Mappings list, add a new record. 

3 In the Project Mappings list, in the Mapping Name field, enter a name of your 
own choosing to identify the mapping template you are creating and the data 
relationships it defines.

4 In the Description field, enter a description of the mapping.

5 In the Mapping Categories list, add a new record. 

6 In the new record, select the appropriate category from the Category drop-down 
list:

■ If you are creating a mapping template for importing and exporting project 
resource information, select Project Resources.

■ If you are creating a mapping template for importing and exporting task 
information, select Tasks.

■ If you are creating a mapping template for importing and exporting both 
project resource and task information, choose either category. After you 
finish defining mappings for the first category you choose, a later step of this 
procedure will direct you to repeat the necessary steps to define mappings 
for the other category.
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7 In the Category Fields list, below the Mapping Categories list, add a new record.

8 Complete the fields in the new record. Some of the fields are described in the 
following table.

NOTE: Repeat Step 7 and Step 8 of this procedure until you have mapped each 
needed field for the selected Category. If you need an additional Category for this 
template, repeat Step 6 on page 102 through Step 8 of this procedure, specifying 
the additional Category in Step 6 on page 102.

Field Comments

Comments Text field for comments about the mapping between the 
specified Siebel field and the specified Microsoft Project field.

Import/Export Indicates whether the mapping specified in this record can 
be used to import data from Microsoft Project into the Siebel 
database, export data from the Siebel database into Microsoft 
Project, or both.

MS Project Field Name Name of a field in Microsoft Project that you want to map to 
the Siebel field specified in this record. Available values are 
set in the PS_MPP_FIELD_TYPE list of values.

Some items listed in the MS Project Field Name drop-down 
list may not have corresponding Siebel fields. If a 
corresponding Siebel field does not exist, an extension field 
can be created. For more information on creating an 
extension field, see Siebel Tools Reference.

Sequence (Optional) Determines the order in which the fields from the 
Siebel application that have Sequence specified will be 
exported to Microsoft Project. This sequence can affect 
scheduling. When fields have interrelated values, the last 
field to be exported determines the outcome. For example, if 
Start and Duration are exported before End, Microsoft Project 
calculates a value for Duration, instead of using the exported 
value. If Start and End are exported before Duration, 
Microsoft Project calculates a value for End, instead of using 
the exported value.

Siebel Field Name Name of a Siebel task or resource field that you want to map 
to the Microsoft Project field specified in this record. 
Available values are the business component fields of the 
business component that you selected for the template’s 
Category.
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The following procedure explains how to modify an existing mapping template. You 
can use this procedure with any of the following kinds of mapping templates:

■ The templates that are provided with Siebel Professional Services Automation.

■ Copies of the templates that are provided with Siebel Professional Services 
Automation.

■ Templates that you create.

To modify a mapping template

1 From the application-level menu, choose View > Site Map > Data 
Administration > Project Mappings.

2 In the Project Mappings list, select the mapping template that you want to 
modify.

3 If you want to modify a copy of the selected template, click the menu button, 
Copy Record, and then enter a new Mapping Name for the copy; otherwise, skip 
this step.

4 In the Mapping Categories list, add or delete category records as needed.

5 In the Category Fields list, add, delete, or modify records as needed.
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Importing Information from Microsoft Project into Siebel 
Professional Services Automation

End users can import information from Microsoft Project into Siebel Professional 
Services Automation by using the Plan Integration view in the Projects screen. As 
part of this process, an existing template must be specified that defines how 
Microsoft Project fields are mapped to Siebel Professional Services Automation 
fields. For general information about these templates, see “Understanding Mapping 
Templates (Administrator)” on page 98.

The following procedure explains how to import a Microsoft Project file into the 
Siebel database. As part of this process, end users can attach the file to either a new 
record or an existing record in the Plan Integration view. To preserve a historical 
record of Siebel data and Microsoft Project data throughout the project, end users 
can use a new plan integration record for each importation. If there is no need for 
the historical record, end users can use an existing plan integration record, which 
causes older data to be overwritten with newer data.

NOTE: After each importation of data from Microsoft Project to Siebel Professional 
Services Automation, end users can click the Update button in the Plan Integration 
list to verify that the importation process is finished. The Update button requests an 
update on the import process from the Siebel Document Server and refreshes the 
Projects Tasks and Projects Team Workbook views to reflect the results of the 
import. The process is finished when clicking the Update button makes the value 
Completed appear in the Import Status field.

To import a Microsoft Project file into your Siebel database

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project for which you want to import information 
from Microsoft Project.

4 Click the Plan Integration view tab.
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5 In the Plan Integration list, use one of the following methods to specify the 
record to which your Microsoft Project file will be attached:

■ To preserve records of any earlier importations, or to import a file for the first 
time, add a new plan integration record.

■ To overwrite the most recent importation of an existing file, select the existing 
plan integration record that was used for the earlier importation.

6 In the Attachment Name field, click the select button to display the Add 
Attachment dialog box, and then complete the following substeps:

a In the Add Attachment dialog box, click Browse.

The Choose File dialog box appears.

b In the Choose File dialog box, select the Microsoft Project file that you want 
to import and click Open.

7 If you have not previously specified a mapping template for this record, 
complete the following substeps; otherwise, skip to Step 8.

a In the Plan Integration list, in the Mapping Template field, click the select 
button.

b In the Pick Microsoft Project Mapping dialog box, select the mapping 
template that you want to use and then click OK.

8 In the Plan Integration list, click Import.

9 Wait briefly, and then, in the Plan Integration list, click Update.

If the import process is finished, a value of Completed appears in the Import 
Status field. If the import process is not finished, repeat this step.
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Exporting Information from Siebel Professional Services 
Automation to a New Microsoft Project File

End users can export information from Siebel Professional Services Automation to 
a Microsoft Project file by using the Plan Integration view in the Projects screen. As 
part of this process, end users must specify an existing template that defines how 
Siebel Professional Services Automation fields are mapped to Microsoft Project 
fields. For general information about these templates, see “Understanding Mapping 
Templates (Administrator)” on page 98.

To preserve a historical record of Siebel data and Microsoft Project data throughout 
the project, end users can use a new Microsoft Project file each time they export. If 
there is no need for a historical record, end users can use an existing Microsoft 
Project file, which causes older data to be overwritten with newer data.

NOTE: After each time end users export Siebel Plan Integration data to a Microsoft 
Project file, they must click the Update button in the Plan Integration list to verify 
that the export process is finished. The Update button requests an update on the 
export process from the Siebel Document Server. The process is finished when 
clicking the Update button makes the value Completed appear in the Export Status 
field.

To export Siebel information to a new Microsoft Project file

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project for which you want to export information 
to Microsoft Project.

4 Click the Plan Integration view tab.

5 In the Plan Integration list, add a new record. 

6 In the Attachment Name field, type in the name of the Microsoft Project file that 
you want to create and then export to.

7 In the Plan Integration list, in the Mapping Template field, click the select 
button.
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8 In the Pick Microsoft Project Mapping dialog box, select the mapping template 
that you want to use, and then click OK. 

9 In the Plan Integration list, click Export. 

10 Wait briefly, and then, in the Plan Integration list, click Update.

If the export process is finished, a value of Completed appears in the Export 
Status field. If the export process is not finished, repeat this step. 

11 After Completed appears in the Export Status field, click the Attachment Name 
hyperlink to view the exported information in Microsoft Project.
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Exporting Information from Siebel Professional Services 
Automation to an Existing Microsoft Project File

The following procedure explains how to export information about tasks, resources, 
or both, from the Siebel database to an existing Microsoft Project file. 

To export Siebel information to an existing Microsoft Project file

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project for which you want to export information 
to Microsoft Project.

4 Click the Plan Integration view tab.

5 In the Plan Integration list, select the record that lists the Microsoft Project file 
to which you want to export.

6 In the Plan Integration list, in the Mapping Template field, click the select 
button.

7 In the Pick Microsoft Project Mapping dialog box, select the mapping template 
that you want to use, and then click OK. 

8 In the Plan Integration list, click Export.

9 Wait briefly, and then, in the Plan Integration list, click Update.

If the export process is finished, a value of Completed appears in the Export 
Status field. If the export process is not finished, repeat this step. 

10 After Completed appears in the Export Status field, click the Attachment Name 
hyperlink to view the exported information in Microsoft Project.
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Viewing a Log File
Each time end users import data from Microsoft Project into Siebel Professional 
Services Automation or export data from Siebel Professional Services Automation 
to Microsoft Project, a log file is generated. This log file records transactions that 
take place during the import or export process and any exceptional handling that is 
required. The following procedure explains how to view such a log file.

To view an import or export log file

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project for which you want to view an import or 
export log.

4 Click the Plan Integration view tab.

5 In the Plan Integration list, select the record to which you imported or from 
which you exported.

6 In the Log field, click the hyperlink.

7 In the dialog box that appears, use standard Windows techniques to open the 
file from its current location or download it to your local system.
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Saving a Log File
The log file associated with each record is regenerated every time an import or 
export process is performed, overwriting the previous version of the log. The 
following procedure explains how to save a log file permanently.

To save a log file permanently

1 Complete the procedure, “Viewing a Log File” on page 110.

2 With the log file open, select Save As from the File menu.

3 Specify a file name, location, and type, and then click Save.

NOTE: If duplicate values are present in the Name field of a Microsoft Project 
resource sheet, any attempt to import the data into the Siebel database will fail 
without importing any data. This occurs because the Name field in a Microsoft 
Project resource sheet is mapped to the Resource Nick Name field in the Siebel team 
workbook, which is a unique key in the Siebel database. 
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This chapter explains how to administer and use time sheet reporting functionality. 
Many procedures in this chapter resemble procedures for expense reports. The end-
user procedures in this chapter can be used by any Siebel application user who 
needs to report time spent on specific projects or work tasks.

Siebel time reporting allows your organization to log and track how time is spent so 
you can detect and eliminate inefficiencies, allocate your resources, and bill 
customers appropriately. You can measure costs of sales and monitor actual versus 
budgeted project costs. You can gather and analyze information about how time is 
used at the project, task, or activity level, according to your business requirements.

At the operational level, employees can log their time in a diary format or directly 
into time sheets covering specific periods. Automated notification and routing speed 
up the time sheet approval process. Managers can adjust billable hours directly, or 
can return time sheets to subordinates for correction. Finally, the time reporting 
functionality in your Siebel application can be integrated with a back-office system 
for customer invoicing.
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Business Scenario for Time Reporting and Time Sheets
This scenario provides an example of a time reporting business process performed 
by a Siebel administrator, a consultant, and a consulting manager. Your company 
may follow a different process according to its business requirements.

A Siebel administrator at a large consulting company is responsible for setting up 
time sheets for the use of employees. First he creates additional time sheet work 
types to meet the special needs of some of the consultants in the company and he 
changes the existing period type to match the company’s reporting process. He then 
must define reporting relationships between users to accommodate the approval 
process of time sheets. With these relationships he must set up limits that determine 
the number of hours each manager can approve per time sheet. Any time sheet that 
exceeds the limit is automatically routed to another approver, as determined by the 
reporting relationships he defined. 

The administrator is also responsible for configuring time sheets. He can change the 
name and position of a time sheet’s dynamic buttons to meet the needs of the 
company. He can also add new dynamic buttons as needed. Sometimes he even has 
to specify dynamic button inheritance for a new detail view. Finally, he must change 
the trigger for the Submit To field in a time sheet when a user prefers not to use the 
value Pending Next Approver as the trigger to change the Submit To value.

A number of things must be activated by the Siebel administrator before users can 
successfully work with time sheets. Therefore, the administrator activates Auto Gen 
so that users can automatically submit their time sheets. He also activates email 
notification, status updating, Add Time Item workflow functionality, and Go to My 
Time Sheets workflow functionality.

One of the company’s typical consultants logs time against projects, tasks, and 
activities. She enters her time using the My Time Diary view, which lets her log time 
entries without having to create a time sheet first. After completing her time entries, 
she selects the Auto Gen functionality for time sheets to automatically generate a 
time sheet for the current reporting period. She reviews her time sheet and submits 
the time sheet to her manager for review and approval.
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Another way the consultant can enter time is to enter it directly into a time sheet. 
For example, she can create a new time sheet and select the desired reporting 
period. She can then enter time items into the time sheet using either the Time 
Sheet Item Summary view or the Time Sheet Item Details view. Before submitting 
her time sheet, there are a number of things she may want to do to it. She can move 
time entries from the My Time Diary to her time sheet, move time entries from one 
project to another, or print her time sheet. Once she is satisfied with the time sheet, 
she submits it to her manager for review and approval. After submitting her time 
sheet, she may find that she made an error, and wants to make a change. She can 
recall the time sheet from her manager, correct the mistake, and resubmit the time 
sheet. After resubmitting it, she monitors the status of her time sheet, so that she 
will know when it has been approved.

The company’s consulting manager routinely manages consultants on client 
projects. His responsibilities include managing the time reporting of his 
subordinates. At the end of the reporting period, he reviews any time sheets that 
require his approval in the Time Sheet Approval view. He also uses the Time Sheet 
Summary view and the Time Sheet Adjustments chart to view time details relating 
to an entire project. After reviewing one of his consultant’s submitted time sheets, 
he decides whether to approve or reject it. If he rejects the time sheet, it is returned 
to the consultant for modification and resubmission. If he approves the time sheet, 
and if the number of hours is within his approval limit, the time sheet status is 
changed to Acceptable.

After the time sheet has been approved and status is changed to Acceptable, a 
financial administrator reviews the time sheet. If the financial administrator 
approves the time sheet, it is then processed for back-office reporting. After process 
completion, the financial administrator changes the status to Processed. 
Alternatively, the financial administrator can reject the time sheet, which is then 
returned to the consultant for modification. This administrative process is likely to 
be automated and connected to a back-office system such as PeopleSoft or SAP. The 
status change may be accomplished using a data hand-off between the back-office 
system and the Siebel application.
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Example Process for Time Reporting and Time Sheets
This is an example of a process an administrator and an end user may follow for 
time reporting and time sheets. Your company may follow a different process 
according to its business requirements.

Administrator Procedures
The following administrator procedures describe how to set up values that users 
will choose from when working with time sheets, how to set up processing 
parameters such as reporting structures and approval limits, and how to activate 
workflows for time reporting.

1 Create a time sheet work type. For information, see “Creating Time Sheet Work 
Types (Administrator)” on page 119.

2 Add or modify an available period type. For information, see “Adding or Modifying 
Available Period Types for Time Sheets (Administrator)” on page 120.

3 Define a reporting relationship. For information, see “Defining Reporting 
Relationships (Administrator)” on page 121.

4 Set an approval limit for a user. For information, see “Setting User Approval Limits 
(Administrator)” on page 122.

5 Change the name of a dynamic button. For information, see “Changing the Names 
of Dynamic Buttons for Time Sheets (Administrator)” on page 123.

6 Change the position of a dynamic button. For information, see “Changing the 
Positions of Dynamic Buttons for Time Sheets (Administrator)” on page 124.

7 Add a dynamic button to a new view. For information, see “Adding Dynamic 
Buttons to New Views for Time Sheets (Administrator)” on page 125.

8 Specify the inheritance of a dynamic button for a new detail view. For information, 
see “Specifying Inheritance of Dynamic Buttons for a New Detail View for Time 
Sheets (Administrator)” on page 126.

9 Change the trigger for the Submit To field in a time sheet. For information, see 
“Changing the Trigger for the Submit To Field for Time Sheets (Administrator)” 
on page 128.
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10 Activate Auto Gen for time sheets. For information, see “Activating Automatic 
Generation for Time Sheets (Administrator)” on page 129.

11 Activate email notification for a time sheet. For information, see “Activating Email 
Notification for Time Sheets (Administrator)” on page 130.

12 Activate status updating for time sheets. For information, see “Activating Status 
Updating for Time Sheets (Administrator)” on page 132.

13 Activate the Add Time Item to the time sheet workflow. For information, see 
“Activating the Add Time Item to the Time Sheet Workflow (Administrator)” on 
page 133.

14 Activate the Go to My Time Sheets view workflow. For information, see “Activating 
the Go to My Time Sheets View Workflow (Administrator)” on page 134.

End-User Procedures
The following end-user procedures describe how to record time worked, how to 
view information related to time worked, and how to create, modify, and process 
time sheets.

1 Record time in the My Time Diary view. For information, see “Recording Time 
Worked in the My Time Diary View” on page 135.

2 Record time in the Activities Time view. For information, see “Recording Time 
Worked in the Activities Time View” on page 137.

3 Create a time sheet automatically. For information, see “Creating a Time Sheet 
Automatically” on page 139.

4 Create a time sheet manually. For information, see “Creating a Time Sheet 
Manually” on page 140.

5 Use the Time Sheet Item Summary view and Spread button. For information, see 
“Using the Time Sheet Item Summary View and the Spread Button” on page 143.

6 Use the Time Sheet Item Detail view and the Next Day button. For information, see 
“Using the Time Sheet Item Detail View and the Next Day Button” on page 145.

7 Move time entries from My Time Diary to Time Sheets. For information, see “Moving 
Time Entries from My Time Diary to Time Sheets Manually” on page 147.
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8 Remove a line item time entry from a time sheet. For information, see “Removing 
Line Item Time Entries from Time Sheets” on page 148.

9 Submit a time sheet. For information, see “Submitting a Time Sheet” on page 149.

10 Recall a submitted time sheet. For information, see “Recalling a Submitted Time 
Sheet” on page 150.

11 Monitor the status of a time sheet. For information, see “Monitoring the Status of 
a Time Sheet” on page 151.

12 Print a time sheet. For information, see “Printing a Time Sheet” on page 152.

13 Create a time sheet for another person. For information, see “Creating a Time Sheet 
for Another End User” on page 153.

14 Approve or reject a time sheet. For information, see “Approving or Rejecting Time 
Sheets” on page 154.

15 Accept or reject a time sheet before back-office processing. For information, see 
“Accepting or Rejecting Time Sheets Before Back-Office Processing” on 
page 156.

16 Adjust the hours of a submitted time sheet. For information, see “Adjusting 
Submitted Time Sheet Hours” on page 157.

17 Move a time entry from one project to another. For information, see “Moving a Time 
Entry From One Project to Another” on page 158.

18 Move multiple time entries from one project to another. For information, see 
“Moving Multiple Time Entries from One Project to Another” on page 159.

19 View a time sheet summary and a time sheet summary chart. For information, see 
“Viewing a Time Sheet Summary and Time Sheet Summary Chart” on page 160.

20 View a time sheet adjustments chart. For information, see “Viewing a Time Sheet 
Adjustments Chart” on page 161.
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Creating Time Sheet Work Types (Administrator)
Time sheets require that each increment of work time be reported against either a 
project or a work type. If your Siebel application includes Siebel Professional 
Services Automation or Siebel Projects, end users can report time against private 
projects and public projects. In this release, public projects are used to represent 
common time reporting categories such as Vacation and Training. Public projects 
fulfill the same function as work types, with less need for maintenance, because 
public projects are automatically available to each user, and work types are only 
available to users who have explicitly been granted access to those work types. If 
your Siebel application does not include Siebel Professional Services Automation or 
Siebel Projects, end users must report time against work types. 

End users select work types in drop-down lists in time sheet views. Your Siebel 
application comes with default work types, such as Travel, Vacation, and Sick Time. 
You can add more work types to suit your company’s time sheet needs. The 
following procedure explains how to add a new work type. 

To create a work type

1 From the application-level menu, choose View > Site Map > Application 
Administration > Work Types.

2 In the Work Types list, add a new record.

3 Complete the fields in the new record. Some of the fields are described in the 
following table.

Field Comments

Access Users who can select this work type in their time sheets. Defaults to 
creator’s User ID. Note that if you want to add additional values to this field, 
you must select the record and click the select button (not the hyperlink) in 
this field.

End Date on which the work type becomes unavailable to end users. Defaults to 
NULL.

Name Name that end users see when choosing Project field values for time sheet 
line items.
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Adding or Modifying Available Period Types for Time 
Sheets (Administrator)

When creating a time sheet, a user selects the time period the time sheet covers. By 
default, the Pick Period dialog box displays only periods of the type Week, some of 
which are supplied with the application. If using a period of type Week does not 
suit your implementation, you can use Siebel Tools to specify a new period type or 
to allow users to pick from multiple period types. For information about specifying 
new period types for use with both time sheets and expense reports, see “Adding or 
Modifying Available Periods (Administrator)” on page 173.

Start Date on which the work type becomes available to end users.

Status Defaults to Active. When set to Active, the selected work type is visible to 
end users. Whether it is available to end users depends on the values chosen 
for Start and End. If an end user selects a work type during a time period 
outside the range set by Start and End, an error message appears.

Field Comments
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Defining Reporting Relationships (Administrator)
The reporting relationships you define for your Siebel application are a part of the 
infrastructure for approving time sheets. When a user creates a time sheet, the value 
of the Submit To field defaults to the User ID of the person to whom that user 
reports, but the user can override the default if necessary. If the reporting structure 
has not been defined, the user cannot save the time sheet or use Auto Gen for 
transferring time diary entries into the current report.

The following procedure explains how to set the reporting relationship between a 
subordinate and the supervisor or manager to whom the subordinate reports. This 
procedure must be followed for every user who is allowed to submit time sheets or 
expense reports. Reporting relationships apply to both time sheets and expense 
reports.

NOTE: The following procedure establishes a relationship between two positions, 
rather than two employees. If more than one employee is associated with a parent 
position, the primary employee for that position is used as the approver for time 
sheets and expense reports submitted by employees who are associated with the 
child position. 

To define a reporting relationship

1 From the application-level menu, choose View > Site Map >Group 
Administration >Positions.

2 In the Positions list, select the position of the user who will submit time sheets 
or expense reports. 

3 In the More Info form Parent Position field, click the select button.

4 In the Pick Parent Position dialog box, select the position of the user who will 
normally approve the time sheets of the user in Step 2, and then click OK.
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Setting User Approval Limits (Administrator)
Based on the reporting structure of your organization, you must set up limits that 
determine the number of hours each manager can approve per time sheet. Any time 
sheet that exceeds the limit is automatically routed to another approver, as 
determined by the reporting relationships you have defined. The following 
procedure explains how to set the approval limit amount for a particular approver.

To set time sheet hours approval limits

1 From the application-level menu, choose View > Site Map > User 
Administration > Employees.

2 In the Employees list, select the employee for whom the approval limit will be 
set.

3 In the More Info form, click the show more button.

4 In the Time Sheet Hours Approval Limit field, enter the maximum number of 
hours the selected employee can approve per time sheet.
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About Dynamic Buttons (Administrator)
A dynamic button is a button whose availability depends on the currently selected 
view. It is activated based on the state of the currently selected record, as defined 
in the Siebel State Model. For information about using the State Model, see Siebel 
Business Process Designer Administration Guide.

Various Time Sheet views in your Siebel application contain dynamic buttons. The 
buttons are used in the time sheet approval process. By default, these buttons are 
labelled Submit, Approve, Process, Recall, and Reject. You can configure the 
following properties of these dynamic buttons:

■ Name that is displayed on each button

■ Left-to-right sequence in which buttons are displayed, when two or more 
dynamic buttons are displayed together

■ Views that display dynamic buttons

This section explains how to make each of these configuration changes. Because 
dynamic buttons are managed as List of Values (LOV) entries, you can reconfigure 
them without using Siebel Tools. 

NOTE: Standard dynamic button configurations are included in the seed data that 
comes with your Siebel application. If you do not use Siebel seed data in your 
implementation, you must either recreate the standard dynamic button 
configurations or load the configurations from the seed data into your system. For 
information about working with seed data, see the Siebel Server installation guide 
for the operating system you are using.

Changing the Names of Dynamic Buttons for Time Sheets 
(Administrator)
The following procedure explains how to change the name that is displayed on a 
dynamic button.

To change the name of a dynamic button for time sheets

1 From the application-level menu, choose View > Site Map > Applications 
Administration > List of Values.

2 In the List of Values list, click Query.
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3 Enter *DYN* in the Type field, and then click Go.

The dynamic buttons for time sheets each have the Type field set to 
TMSHT_DYNAMIC_BT.

4 Select the dynamic button that has a name you want to change.

5 Enter the new name in the Display Value field and the Language-Independent 
Code field.

6 In the List of Values list, click the menu button, and then click Save Record.

7 Click Clear Cache. 

This step reloads dynamic button settings into the server cache. When this 
process is finished, the modified dynamic button is available for use.

Changing the Positions of Dynamic Buttons for Time Sheets 
(Administrator)
The following procedure explains how to change the left-to-right sequence in which 
dynamic buttons are displayed, when two or more dynamic buttons are displayed 
together.

To change the relative positions of dynamic buttons for time sheets

1 From the application-level menu, choose View > Site Map > Applications 
Administration > List of Values.

2 In the List of Values list, click Query.

3 Enter *DYN* in the Type field, and then click Go.

The dynamic buttons for time sheets each have the Type field set to 
TMSHT_DYNAMIC_BT.

4 Find the dynamic buttons that you want to place in a new sequence.
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5 In the Order field, enter a new sequence number for each button you are placing 
in a new sequence.

NOTE: If buttons have identical sequence numbers, they will be displayed in 
alphabetical order.

6 In the List of Values list, click the menu button, and then click Save Record.

7 Click Clear Cache. 

This step reloads dynamic button settings into the server cache. After this 
process is finished, the applicable Time Sheet views display the buttons in their 
new order.

Adding Dynamic Buttons to New Views for Time Sheets 
(Administrator)
The following procedure explains how to display the dynamic buttons for time 
sheets in a new view. It is appropriate for new views that are reached directly from 
the Site Map, the Show drop-down list, or a screen tab.

To add dynamic buttons for time sheets to new views

1 From the application-level menu, choose View > Site Map > Applications 
Administration > List of Values.

2 Display the High and Low columns using Columns Displayed. For information 
about using Columns Displayed functionality, see Fundamentals.

3 In the List of Values list, click Query.

4 Enter *DYN* in the Type field, and then click Go.

The dynamic buttons for time sheets each have the Type field set to 
TMSHT_DYNAMIC_BT.

5 Select a button that you want to add to one or more new views.
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6 In the Low field, enter the names of the new views to display this button, 
preceding each view name and following the final view name with the percent 
sign (%). 

For example, if you want to add the selected button to views NewViewA and 
NewViewB, you would enter %NewViewA%NewViewB%, without intervening 
spaces.

7 In the List of Values list, click the menu button, and then click Save Record.

NOTE: Repeat Step 5 on page 125 through Step 7 of this procedure for each 
additional button that you want to display in new views.

8 Click Clear Cache. 

This step reloads dynamic button settings into the server cache. After this 
process is finished, the new views you specified display the dynamic buttons 
you specified.

Specifying Inheritance of Dynamic Buttons for a New Detail View 
for Time Sheets (Administrator)
The following procedure is appropriate for views that are reached by clicking view 
tabs (including the More Info tab) or by clicking a hyperlink in a list. LOV records 
of type TMSHT_DYNAMIC_BT are modified in the dynamic button procedures 
discussed in the preceding paragraphs. LOV records of type 
TMSHT_DETAIL_VIEWS also affect dynamic buttons in time sheets. 
TMSHT_DETAIL_VIEWS records specify the views that inherit dynamic buttons 
from a related view. 

For example, if you navigate to the My Time Sheets view, Submit and Recall buttons 
are displayed on both the Time Sheets list and the More Info form. If you click the 
Line Items view tab, a Time Sheet form and a Line Items list appear. The Time Sheet 
form displays Submit and Recall buttons that it has inherited from the My Time 
Sheets view. This inheritance is specified by placing the value “%Time Sheet Line 
Items Summary View%Time Sheet Line Items Detail View%” in the description 
field of a TMSHT_DETAILS_VIEW LOV record. The following procedure explains 
how to specify dynamic button inheritance for a new detail view.
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To specify detail views to inherit dynamic buttons for time sheets

1 From the application-level menu, choose View > Site Map > Applications 
Administration > List of Values.

2 Display the Description column using Columns Displayed. For information 
about using Columns Displayed functionality, see Fundamentals.

3 In the List of Values list, click Query.

4 Enter TMSHT_DETAIL_VIEWS in the Type field, and then click Go.

5 Select an existing TMSHT_DETAIL_VIEWS record.

6 In the Description field, add the names of the views that you want to have inherit 
dynamic buttons from related views, preceding each view name and following 
the final view name with the percent sign (%). 

For example, if you want NewViewC and NewViewD to inherit dynamic buttons 
from related views, and if the Description field already includes %ViewA%, 
your final value should be %ViewA%NewViewC%NewViewD%, without 
intervening spaces.

7 In the List of Values list, click the menu button, and then click Save Record.

8 Click Clear Cache. 

This step reloads dynamic button settings into the server cache. After this 
process is finished, the views you specified inherit dynamic buttons from related 
views.
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Changing the Trigger for the Submit To Field for Time 
Sheets (Administrator)

By default, Siebel Professional Services Automation uses the Pending Next 
Approver time sheet Status value as a trigger to change the value in the Submit To 
field from the current approver’s user ID to the user ID of the next approver. If you 
prefer not to use the value Pending Next Approver as the trigger to change the 
Submit To value, you must complete several tasks. The following procedure briefly 
explains how to change the trigger for the Submit To field.

NOTE: A similar procedure applies if you want to change the trigger for the Submit 
To field for expense report approvals. Because you must use Siebel Tools and 
recompile your .srf file for either procedure, you may want to combine the time 
sheet and expense report procedures, so you can recompile only once. For 
information about the expense report procedure, see “Changing the Submit To Field 
Trigger for Expense Reports (Administrator)” on page 183.

To change the trigger value for the Submit To field for time sheets

1 Locate the List of Values record that has Type set to TMSHT_STATUS and Display 
Value set to Pending Next Approver.

2 Replace both the Display Value and the Language-Independent Code value with 
the value you have chosen as the trigger.

3 Modify the Update Time Sheet Status workflow to replace “Pending Next 
Approver” with the value you have chosen as the trigger.

4 Modify the Time Sheet Approval state model to replace “Pending Next 
Approver” with the value you have chosen as the trigger.

5 In Siebel Tools, make the following changes:

a Locate the Time Sheet business component. 

b Add a business component User Property with Name set to Next Approver 
Status and Value set to the value you have chosen as the trigger.

c Recompile the .srf file.
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Activating Automatic Generation for Time Sheets 
(Administrator)

The Auto Gen feature lets each user transfer multiple line items of time usage 
information from the My Time Diary view to a current time sheet, by means of a 
single command. The following procedure explains how to make the Auto Gen 
capability available to your users.

To activate Auto Gen for time sheets

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 In the Workflow Processes list, click Query.

3 In the Name field, enter Time Sheet AutoGen, and then click Go.

4 In the Workflow Processes list, select the version of Time Sheet AutoGen with 
the highest Version number, and then click Revise.

A new record is created with a status of In Progress and a higher version number.

5 In the Activation Date/Time field, enter a date and time after which you want 
Auto Gen to be available.

6 In the Expiration Date/Time field, enter a date and time after which you want 
Auto Gen to be unavailable.

7 In the Workflow Processes list, click Activate.

If the process is successful, the Status field changes from In Progress to Active.
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Activating Email Notification for Time Sheets 
(Administrator)

The following procedure explains how to activate the workflow that provides 
automatic email notification during the time sheet approval process. These 
messages notify time sheet approvers when they need to review particular time 
sheets, and provide time sheet submitters with updates on the progression of their 
time sheets through the approval process. This procedure assumes that your Siebel 
Communications Server has already been set up and configured, as described in 
Siebel Communications Server Administration Guide.

To activate email notification for time sheets

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 In the Workflow Processes list, click Query.

3 In the Name field, enter Time Sheet Process, and then click Go.

4 In the Workflow Processes list, select the version of Time Sheet Process with the 
highest Version number, and then click Revise.

A new record is created with a status of In Progress and a higher version number.

5 In the Activation Date/Time field, enter a date and time after which you want 
notification to be available.

6 In the Expiration Date/Time field, enter a date and time after which you want 
notification to be unavailable.
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7 Complete the following substeps to verify associated workflow policy settings:

a From the Show drop-down list, select Workflow Policies.

b In the Policies List list, query to locate the following policies:

❏ Send Time Sheet Approval Email policy

❏ Send Time Sheet Approval Email to New Approver policy

c Make sure that the Activation and Expiration settings for these policies match 
the Activation Date/Time and Expiration Date/Time settings you specified in 
Step 5 and Step 6 on page 130.

d From the Show drop-down list, select Workflow Processes.

8 In the Workflow Processes list, re-select the Time Sheet Process record that has 
a status of In Progress, and click Activate.

The Status field changes from In Progress to Active.
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Activating Status Updating for Time Sheets 
(Administrator)

The following procedure explains how to activate the workflow that updates a time 
sheet status of Approved to a status of Acceptable or Pending Next Approver. This 
depends on whether or not the most recent approver is authorized to approve the 
number of hours reported in the time sheet.

To activate status updating for time sheets

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 In the Workflow Processes list, click Query.

3 In the Name field, enter Update Time Sheet Status, and then click Go.

4 In the Workflow Processes list, select the Update Time Sheet Status record with 
the highest value in the Version field, and then click Revise.

A new record is created with a status of In Progress and a higher version number.

5 In the Activation Date/Time field, enter a date and time after which you want 
status updating to be available. 

NOTE: If no value is specified, this functionality becomes available when you 
select the workflow and click Activate, as described later in this procedure.

6 In the Expiration Date/Time field, enter a date and time after which you want 
status updating to be unavailable.

If no value is specified, status updating remains available until manually 
deactivated.

7 In the Workflow Processes list, click Activate.

The Status field changes from In Progress to Active.
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Activating the Add Time Item to the Time Sheet Workflow 
(Administrator)

In the My Time Diary view, users can add time items from previous reporting 
periods to the appropriate time sheets by using the Add to Time Sheet command. 
The following two procedures describe how to activate two workflows that support 
the Add to Time Sheet command. This workflow moves time items from the My 
Time Diary view to a time sheet. For information about using the Add to Time Sheet 
command, see “Moving Time Entries from My Time Diary to Time Sheets 
Manually” on page 147.

To activate the Add Time Item to Time Sheet workflow

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 In the Workflow Processes list, click Query.

3 In the Name field, enter Add Time Item to Time Sheet, and then click Go.

4 In the Workflow Processes list, select the Add Time Item to Time Sheet record 
with the highest value in the Version field, and then click Revise.

A new record is created with a status of In Progress and a higher version number.

5 In the Activation Date/Time field, enter a date and time after which you want 
status updating to be available. 

NOTE: If no value is specified, this functionality becomes available when you 
select the workflow and click Activate, as described later in this procedure.

6 In the Expiration Date/Time field, enter a date and time after which you want 
status updating to be unavailable.

NOTE: If no value is specified, status updating remains available until manually 
deactivated.

7 In the Workflow Processes list, click Activate.

The Status field changes from In Progress to Active.
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Activating the Go to My Time Sheets View Workflow 
(Administrator)

This second workflow displays the My Time Sheets view to the user after the Add 
to Time Sheet command is used.

To activate the Go to My Time Sheets view workflow

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 In the Workflow Processes list, click Query.

3 In the Name field, enter Go to My Time Sheets*, and then click Go.

4 In the Workflow Processes list, select the Go to My Time Sheets view record with 
the highest value in the Version field, and then click Revise.

A new record is created with a status of In Progress and a higher version number.

5 In the Activation Date/Time field, enter a date and time after which you want 
status updating to be available. 

If no value is specified, this functionality becomes available when you select the 
workflow and click Activate, as described later in this procedure.

6 In the Expiration Date/Time field, enter a date and time after which you want 
status updating to be unavailable.

If no value is specified, status updating remains available until manually 
deactivated.

7 In the Workflow Processes list, click Activate.

The Status field changes from In Progress to Active.
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Recording Time Worked in the My Time Diary View
My Time Diary is a view in which end users can record time worked and can specify 
how the time should be logged against projects, tasks, or activities.

The following procedure explains how to record time worked using the My Time 
Diary view.

To record time worked using the My Time Diary view

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Diary.

3 In the My Time Diary list, add a new record.

4 Complete the fields in the My Time Diary list. Some of the fields are described 
in the following table.

Field Comments

Account Customer or potential customer organization associated with the 
time worked.

Activity Activity that required the time worked.

Billable When selected, indicates that the time can be billed to the 
associated account. 

Class Read-only. General category of time spent. Defaults to the Billing 
Class of the selected Project. Typical values include Client 
Billable, Client Investment, and Internal. Available values are set 
in the PROJECT_CLASS list of values. 

Date Date on which the work was performed.

Effective Rate Read-only. Amount to be charged per unit of time. Depends on the 
value of the Project Role field.

Elapsed Time Read-only. Time difference between Start and End values. 
Automatically calculated.

End Date when the time worked was concluded.

Opportunity Sales opportunity associated with the time worked. 
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Private Comments Comments that will not appear on the invoice. 

Project Required. Project associated with the time worked. If the time was 
not worked for a specific customer project, you can enter a public 
project or a work type. When you associate a time item with a 
project by completing this field, Siebel Professional Services 
Automation automatically tracks your work in the Time Summary 
and Time Adjustment views in the Projects screen. Entering a 
value in this field and in the Project Role field allows the hourly 
rate to appear in the time sheet (as long as you are on the project 
access list and a role is defined for you in the Team Workbook).

Project Role The function you were fulfilling for the selected project while 
working the reported time. Available values are set in the Team 
Workbook. Used in calculating the Effective Rate. Entering a value 
in this field and in the Project field allows the hourly rate to 
appear in the time sheet (as long as you are on the project access 
list and a role is defined for you in the Team Workbook).

Public Comments Comments that will appear on the invoice. 

Reported Time Amount of time that you are reporting. May differ from Elapsed 
Time. Maximum value is 24 hours.

SR # Service Request associated with the time worked.

Start (Optional) Date when the time worked began.

Task Task associated with the time worked.

Field Comments
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Recording Time Worked in the Activities Time View
The Activity Time view lets end users log time worked for individual activities. 
Time entries recorded in the Activity Time view are also visible in the My Time 
Diary view, until they are included in a time sheet for a specific period. 

The following procedure explains how to record time worked for a specific activity.

To record time worked using the Activities Time view

1 Navigate to the Activities screen.

2 From the Show drop-down list, select My Activities. 

3 In the Activities list, select the activity for which you want to record time 
worked.

4 Click the Time view tab. 
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5 In the Time list, add a new record.

6 Complete the fields. Some fields are described in the following table.

Field Comments

Billable When selected, indicates that the time can be billed to the associated 
account. The Account field is not shown by default in this view, but 
it can be displayed using the Columns Displayed command.

Date Date on which the work was performed.

Elapsed Time Read-only. Time difference between Start and End values. 
Automatically calculated.

End Date when the time worked was concluded.

Project Required. Project associated with the time worked. If the time was 
not worked for a specific customer project, you can enter a public 
project or a work type. When you associate a time item with a project 
by completing this field, Professional Services Automation 
automatically tracks your work in the Time Summary and Time 
Adjustment views in the Projects screen. Entering a value in this field 
and in the Project Role field allows the hourly rate to appear in the 
time sheet (as long as you are on the project access list and a role is 
defined for you in the Team Workbook).

Project Role The function you were fulfilling for the selected project while 
working the reported time. Available values are set in the Team 
Workbook. Used in calculating the Effective Rate. Entering a value in 
this field and in the Project field allows the hourly rate to appear in 
the time sheet (as long as you are on the project access list and a role 
is defined for you in the Team Workbook).

Reported Time Amount of time that you are reporting. May differ from Elapsed Time.

Start Date when the time worked began.
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Creating a Time Sheet Automatically
The following procedure explains how to generate a time sheet that automatically 
includes time entries that are recorded in the My Time Diary view for the current 
reporting period. These entries include time entries that end users entered using the 
Activities Time view, as long as they have not yet been included in a time sheet. 
This procedure can be used from anywhere in your Siebel application. The feature 
used in this procedure is called the Auto Gen functionality. For information about 
creating a time sheet manually, see “Creating a Time Sheet Manually” on page 140.

NOTE: The Auto Gen feature does not create time sheets for previous time periods 
or populate such time sheets with My Time Diary entries from previous time 
periods. To create a time sheet for an earlier period automatically and to move older 
time items from the My Time Diary view to a time sheet for the appropriate time 
period, see “Moving Time Entries from My Time Diary to Time Sheets Manually” 
on page 147.

To create a current time sheet automatically

■ From the application-level menu, select File > Auto > Time Sheet.

If you already have a time sheet for the current period, and if its status is set to 
In Progress, then a workflow moves your time diary entries for the current 
period to the line items section of your existing time sheet. 

If you do not yet have a time sheet for the current period, then a workflow 
creates the time sheet and moves your time diary entries for the current period 
to the line items section of the new time sheet.

If you already have a time sheet for the current period, but its status is not set 
to In Progress, your time diary entries will remain in the My Time Diary view. 
In this case, confer with your manager or a Siebel administrator about how to 
incorporate the time diary entries into the existing time sheet.
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Creating a Time Sheet Manually
If end users have time entries for periods outside the current reporting period, they 
can create time sheets for each of those periods manually, and then use the Add to 
Time Sheet command to move entries into the proper time sheets.

The following procedure explains how to create a time sheet manually. This 
procedure sets up the framework of the time sheet. For instructions on how to add 
line items to the newly created time sheet, see “Adding Line Items to a Time Sheet” 
on page 142.

To create a time sheet manually

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

3 In the Time Sheets list, add a new record.

4 In the new record, complete the necessary fields. Some fields are described in 
the following table.

Field Comments

Account Customer or potential customer organization associated with the 
time worked.

Class General category of time spent. Defaults to the Billing Class of the 
selected Project. Typical values include Client Billable, Client 
Investment, and Internal. Available values are set in the 
PROJECT_CLASS list of values. The value in this field sets the 
default Class value for this time sheet’s line items, but the line item 
Class value is overwritten if the line item Project value is changed.

Created Date on which the time sheet was created. Automatically 
populated.

Description Text field for information about the time sheet.

Division Organizational division of the person who worked the time.

End Final day of the time reporting period.

Name A name to help identify the time sheet.
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Opportunity Sales opportunity associated with the time worked. Automatically 
populated based on the value of the Project field, if there is an 
opportunity associated with the project. 

Period Required. The time period covered by the time sheet. Defaults to 
the current period, but can be changed. Available values are set by 
your Siebel administrator.

Prepared By Read-only. User ID of the person who created the time sheet. 
Automatically populated. The only people who can edit a time 
sheet are the person specified in the Prepared By field and the 
person specified in the Submitted By field.

Project Project associated with the time worked. If the time was not worked 
for a specific customer project, you can enter a public project or a 
work type. The value of this field sets the default value for the 
Project field when entering time line items.

Project # A unique identifier for the project. Automatically populated when 
the project value is picked.

Site Location of the account associated with the time worked. 
Automatically populated when the account value is chosen.

Start First day of the time reporting period.

Status Indicates the stage the time sheet has reached in the approval 
process. If the status is In Progress, the time sheet can be edited.

Submit To Required. The User ID of the person who should approve the time 
sheet. Normally defaults to the User ID of the person to whom you 
report, but can be changed, if, for example, that person is 
unavailable for an extended period.

Submitted By Required. User ID of the person who worked the time being 
recorded.

Time Sheet # A unique identifier for this time sheet. Automatically populated.

Time Sheet Total Sum of the hours recorded in the Line Items view tab. Includes both 
billable and nonbillable hours.

Field Comments
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Adding Line Items to a Time Sheet
If the time entries end users want to add to a time sheet already exist in their time 
diary, they can use the Add To Time Sheet command to move them to the 
appropriate time sheet. For more information about this command, see “Moving 
Time Entries from My Time Diary to Time Sheets Manually” on page 147.

If the time entries end users want to add do not yet exist in their time diary, they 
can enter them (or inspect existing time entries) by using either of the following 
views:

■ Time Sheet Item Summary view. Use this view to add or inspect project-level time 
entries.

■ Time Sheet Item Detail view. Use this view to add or inspect task-level or activity-
level time entries.

When end users use the Time Sheet Item Summary view to specify an amount of 
time worked on a particular day, a corresponding record is automatically created in 
the Time Sheet Item Detail view. Similarly, items that are added directly to the Time 
Sheet Item Detail view are reflected in the hours shown in the Time Sheet Item 
Summary view.

The following sections describe how to add time entries to a time sheet using each 
of these views.

NOTE: If end users create multiple time entries with the same values for Project, 
Project Role, and Billable, the application automatically consolidates the entries in 
the Time Sheet Item Summary view. If the entries are for dates within the same 
week, the view shows a single record with automatically calculated hours totals for 
each day. In this situation, any field that includes a calculated total becomes read-
only. If the value in one of these calculated fields needs to be changed, the change 
must be made in the Time Sheet Item Details view. 
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Using the Time Sheet Item Summary View and the Spread 
Button

The following procedure explains how to add a project-level time entry to a time 
sheet, using the Time Sheet Item Summary View.

In this view, end users can specify time worked for each day. Alternatively, they can 
enter the total number of hours worked for the specified period in the Spread Hours 
field, and then use the Spread button to allocate the hours evenly across each 
workday in the period. For example, if an end user enters 20 hours worked on a 
specific project during the period, clicking Spread allocates 4 hours to each of 5 
workdays.

To add a project-level time entry using the Time Sheet Item Summary view

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

3 In the Time Sheets list, select the time sheet to which you want to add time 
entries, and then click the Line Items view tab.

4 In the Line Items list, from the Show drop-down list, select Summary, and then 
add a new record.

5 In the Project field, click the select button to display the Pick Project dialog box, 
select the project associated with the time entry, and then click OK.

If there is a project specified in the Time Sheet form, the Project field in each 
Line Items record in the Time Sheet Item Summary view defaults to that value. 

6 In the Project Role field, click the select button to display the Pick Project Team 
dialog box, select the role you performed for the selected project, and then click 
OK.

NOTE: Entering values in the Project and Project Role fields allows the hourly rate 
to appear in the time sheet (as long as you are on the project access list and a 
role is defined for you in the Team Workbook).
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7 If the time is billable to a customer, select the check box in the Billable field.

8 Use one of the following methods to specify the time worked for the selected 
project:

■ In each applicable date column, enter the time worked for the selected 
project on that date.

■ In the Spread Hours field, enter the total time worked for the selected project 
during the period, and then click Spread to distribute the hours evenly across 
workdays.
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Using the Time Sheet Item Detail View and the Next Day 
Button

The following procedure explains how to add a task-level or activity-level time entry 
to a time sheet, using the Time Sheet Item Detail View.

In this view, end users can create a blank new record by clicking New. Alternatively, 
they can select an existing record and click the Next Day button to create a record 
that includes the same data as the record selected, except that the Day and Date 
values are automatically increased by one day.

To add a task-level or activity-level time entry using the Time Sheet Item Detail View

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

3 In the Time Sheets list, select the time sheet to which you want to add time 
entries, and then click the Line Items view tab.

4 In the Line Items list, from the Show drop-down list, select Details.

5 In the Line Items list, click the menu button, and then select Columns Displayed.

6 Inspect the Available Columns area of the Columns Displayed dialog box, and 
complete the following substeps:

a If Activity is listed in Available Columns, click Activity, and then click the 
right arrow button to transfer Activity to Selected Columns.

b If Task is listed in Available Columns, click Task, and then click the right 
arrow button to transfer Task to Selected Columns.

c If you want to display any other columns currently listed in Available 
Columns, select each desired column, and then click the right arrow button.

d If you do not want to display any columns currently listed in Selected 
Columns, select each such column, and then click the left arrow button.

e If you want to change the sequence in which columns are displayed in the 
Time Sheet Item Detail view, select columns as needed in the Selected 
Columns area, and click the up or down arrows to adjust the sequence.

f When you are finished, click Save.
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7 In the Line Items list, use one of the following methods to create a new record:

■ Click New to create a new record.

■ Select an existing record and click Next Day to create a copy of the selected 
record with Date and Day values increased by one day.

8 Complete the fields as needed. Some of the fields are described in the following 
table.

Field Comments

Activity Activity for which you worked the time.

Billable When selected, indicates that the time can be billed to the associated 
account. By default, the Account field is not shown in this view, but 
it can be displayed by using the Columns Displayed command.

Class General category of time spent. Defaults to the Billing Class of the 
selected Project. Typical values include Client Billable, Client 
Investment, and Internal. Available values are set in the 
PROJECT_CLASS list of values. The value in this field sets the 
default Class value for this time sheet’s line items, but the line item 
Class value is overwritten if the line item Project value is changed.

Date Date on which you worked the time.

Day Day of the week on which you worked the time. Automatically 
populated based on the value of the Date field.

Effective Rate Read-only. Amount to be charged per unit of time. Depends on the 
value of the Project Role field.

Project Project for which you worked the time. Entering a value in this field 
and in the Project Role field allows the hourly rate to appear in the 
time sheet (as long as you are on the project access list and a role is 
defined for you in the Team Workbook).

Project Role Role you performed for the specified project. Entering a value in this 
field and in the Project field allows the hourly rate to appear in the 
time sheet (as long as you are on the project access list and a role is 
defined for you in the Team Workbook).

Reported Hours Number of hours you worked.

Task Task for which you worked the time.
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Moving Time Entries from My Time Diary to Time Sheets 
Manually

If there are entries in an end user’s time diary that are dated before the current 
reporting period, end users can move them from the time diary to an appropriate 
time sheet by using the Add to Time Sheet command. This is more convenient than 
reentering information in the Time Sheet Item Summary view or the Time Sheet 
Item Detail view.

The Add to Time Sheet command checks whether there is an existing time sheet for 
the time period that includes the time entry. If there is such a time sheet, and if it 
has Status set to In Progress, the Add to Time Sheet command moves the entry from 
the time diary to the correct time sheet. If there is no time sheet for the appropriate 
period, the Add to Time Sheet command automatically creates a new time sheet for 
the appropriate period, and moves the time entry from the diary to that time sheet. 
If there is an existing time sheet for the correct time period but its status is not In 
Progress, an error message appears, and the time entry remains in the time diary. 
In this case, end users should confer with their manager or a Siebel administrator 
about how to incorporate the time diary entry into the existing time sheet.

The following procedure explains how to move a time diary entry to a time sheet 
using the Add to Time Sheet command.

To move a time entry from My Time Diary to a time sheet manually

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, choose My Time Diary.

3 In the My Time Diary list, select the time entry you want to move to a time sheet.

4 In the My Time Diary list, click the menu button and select Add to Time Sheet.
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Removing Line Item Time Entries from Time Sheets
The following procedure explains how to remove a line item time entry from a time 
sheet and return it to the My Time Diary view.

NOTE: This procedure requires that the status of the selected time sheet be In 
Progress. 

To remove a time entry from a time sheet

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, choose My Time Sheets.

3 In the Time Sheets list, select the time sheet that includes the entry you want to 
remove. 

4 Click the Line Items view tab.

5 In the Line Items list, from the Show drop-down list, choose Details.

6 In the Line Items list, select the time entry you want to remove from the time 
sheet.

7 In the Line Items list, click the menu button, and then choose Unreport.

The selected record is removed from the time sheet, and is placed in the My 
Time Diary view.
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After end users create a time sheet and add line items to it, it can be edited as 
necessary until it is submitted for approval. 

When end users submit a time sheet, the application automatically routes it to 
whomever is specified in the Submit To field for evaluation. By default the value in 
the Submit To field is the User ID of the end user’s manager. If the time sheet should 
be submitted to someone other than an end user’s manager (such as the team 
leader or project manager), end users can change the value either before or after the 
time sheet is submitted—the Submit To field remains editable after the time sheet 
is submitted, as do the Private Comments and Public Comments fields.

NOTE: If the Siebel administrator activates email notification for time sheets, an 
email is sent when end users change the Status field to Submitted to notify the time 
sheet approver that a time sheet needs to be approved. For more information about 
activating email notification see, “Activating Email Notification for Time Sheets 
(Administrator)” on page 130.

Each submitted time sheet is either approved or rejected by the person specified in 
the Submit To field. If that person approves the time sheet, the application checks 
whether the total number of hours reported on the time sheet requires further 
approval, and, if so, the time sheet is routed to the next approver. As soon as the 
time sheet is approved by someone who is authorized to approve the total number 
of hours, the time sheet is routed to the financial department, so customers can be 
invoiced for billable time.

The following procedure explains how to submit a time sheet for approval.

To submit a time sheet

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.
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3 In the Time Sheets list, select the time sheet you want to submit, and then click 
Submit.

The value of the Status field changes to Submitted, and an email message is 
automatically sent to the person who is specified in the Submit To field, 
notifying them that there is a time sheet for them to approve.

NOTE: If your time sheet is rejected or revoked, you need to recall it, make the 
necessary changes, and then resubmit it.

Recalling a Submitted Time Sheet
After submitting a time sheet, end users may find that they need to make a 
correction to it, or they may be notified that an approver has rejected or revoked 
their time sheet and is requiring that changes be made to it. If the current status of 
an end user’s time sheet is Submitted, Rejected, or Revoked, end users can use the 
Recall button to change the status back to In Progress, which allows them to make 
the necessary changes. After end users have corrected the time sheet, they can 
resubmit it. For more information about submitting time sheets, see “Submitting a 
Time Sheet” on page 149.

The following procedure explains how to recall a time sheet that has been 
submitted.

To recall a submitted time sheet

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

3 In the Time Sheets list, select the time sheet you want to recall, and then click 
Recall.

The value in the Status field changes to In Progress. At this point, you can make 
changes to the time sheet. If you want to inspect the Private Comments field, 
where an approver may have noted reasons for rejecting the time sheet, continue 
with the remaining steps of this procedure.

4 Click the More Info view tab.

5 In the More Info form, inspect the Private Comments field. 
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After a time sheet has been submitted, the Siebel application uses email to notify 
both the end user and the end user’s manager of its progress. 

For example, when end users submit their time sheet to their manager, the manager 
receives an email notification that there is a time sheet waiting for approval.

Likewise, when the manager has approved or rejected the time sheet, the end user 
receives email notification. End users can also see their submitted and approved 
time sheets in the My Time Sheets view, where the current stage of the approval 
process is shown by the Status field. The following procedure explains how to view 
the approval history of a particular time sheet.

To view the approval history of a time sheet

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

3 In the Time Sheets list, select the time sheet for which you want to view the 
approval history.

4 Click the Approvals view tab.
Version 7.5, Rev. A Siebel Professional Services Automation Guide 151



Time Reporting and Time Sheets

Printing a Time Sheet
Printing a Time Sheet
End users can print time sheets from the Reports menu, as described in the 
following procedure.

To print a time sheet

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

3 In the Time Sheets list, select the time sheet you want to print.

4 From the application-level menu, choose View > Reports.

5 In the Reports dialog box, from the Select a Report drop-down list, select Time 
Sheet.

6 Click Run Now.

The application displays your time sheet in the Siebel Report Viewer window.

7 In the Siebel Report Viewer window, click the Print button.

The time sheet prints to your default printer.
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Creating a Time Sheet for Another End User
The following procedure explains how to create a time sheet, manually, for another 
user of the application. A typical use of this procedure would be for an assistant to 
prepare a time sheet for an executive. This procedure does not require that a formal 
reporting relationship exist—any user who has access to the Assistant’s Time Sheets 
view can prepare a time sheet for another user.

To create a time sheet for another end user

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select Assistant’s Time Sheets.

3 In the More Info form, click the show more button, and then add a new record.

4 In the Submit To field, either enter the User ID of the person who should review 
and approve this time sheet, or click the select button and complete the 
following substeps:

a In the Pick Employee dialog box, use standard query or find techniques to 
locate and select the record that lists the person who should review and 
approve this time sheet.

b Click OK to close the dialog box and place the selected User ID in the Submit 
To field.

5 In the Submitted By field, either enter the User ID of the person who worked the 
time being reported, or click the select button and complete the following 
substeps:

a In the Pick Owned By dialog box, use standard query or find techniques to 
locate and select the record that lists the person who worked the time being 
reported.

b Click OK to close the dialog box and place the selected User ID in the 
Submitted By field.

6 Complete the remaining fields as needed. For descriptions of the fields, see 
“Creating a Time Sheet Manually” on page 140.

NOTE: For information about adding line items to the time sheet, see “Adding 
Line Items to a Time Sheet” on page 142.
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Approving or Rejecting Time Sheets
End users designated as approvers of time sheets for specific employees or specific 
projects receive an email message notifying them each time that a time sheet is 
ready for their review.

NOTE: End users cannot approve a time sheet unless the Time Sheet Hours Approval 
Limit field is filled in their employee record. For more information about setting 
approval limits, see “Setting User Approval Limits (Administrator)” on page 122.

If an end user approves a time sheet for a number of hours that is within their 
approval limit, the time sheet is forwarded to a finance professional, who reviews 
it before it is passed to the back-office system for inclusion in the appropriate 
invoices to customers.

If an end user approves a time sheet for more hours than their approval limit, the 
time sheet is forwarded to someone with a larger approval limit, typically that end 
user’s own manager.

If an end user rejects a time sheet, the person who submitted the time sheet can 
recall it, modify it, and resubmit it.

The following procedure explains how to approve or reject time sheets.

To approve or reject time sheets

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select Time Sheet Approval.

3 In the Time Sheets list, select a time sheet to approve or reject.

If you want to approve multiple time sheets simultaneously, and if you have no 
comments to add to any of the time sheets, hold down the CTRL key while 
selecting multiple time sheets to approve, and skip to Step 5 on page 155.
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4 If you want to record your reason for rejecting a time sheet, enter it in the Private 
Comments field.

5 In the Time Sheets list, click either Approve or Reject.

The value of the Status field changes to Approved or Rejected. For an approved 
time sheet, the Status field is automatically updated again, shortly after you 
leave the record, to display either Acceptable or Pending Next Approver as the 
Status value. 
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Accepting or Rejecting Time Sheets Before Back-Office 
Processing

If the Siebel application is integrated with the organization’s back-office processing 
system, the final step of the time sheet approval process is for a finance professional 
to accept or reject a time sheet before it is passed to the back-office system for 
processing. For example, a time sheet might be rejected if it were incorrectly 
formatted for transfer to the back-office system, or if it were in conflict with a policy 
of the organization.

The following procedure explains how to accept or reject time sheets that have been 
approved by the appropriate managers. Such time sheets have the Status field set to 
Acceptable, and they record a total of reported hours that is within the approval 
limits of the final approvers. This procedure can be performed by any end user who 
has access to the Approved Time Sheets view.

To accept or reject time sheets before back-office processing

1 From the application-level menu, choose View > Site Map > Time Sheets > 
Approved Time Sheets.

2 In the Time Sheets list, select one or more time sheets that you want to accept 
or reject for back-office processing.

3 In the Time Sheets list, click Process or Reject, according to your choice. 

The value of the Status field changes to Processed or Revoked, respectively.
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Adjusting Submitted Time Sheet Hours
From time to time, end users may need to adjust a time sheet that has been 
submitted to them for approval. Ordinarily, end users can reject a time sheet that 
includes errors and have the person who prepared the time sheet correct the error.

On some occasions, however, the time sheet may be correct, but the end user may 
want to adjust the amount to be billed as a courtesy to the customer, or they may 
want to adjust the nonbillable hours submitted for an internal project. End users 
can make an adjustment to the submitted hours of a time sheet at any time before 
the invoice associated with the time worked has its status set to Billed. The 
following procedure explains how to adjust a time sheet’s submitted hours.

To adjust the submitted hours for a time sheet

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the time sheet is associated.

4 Click the Time and Expense view tab.

5 In the Time and Expense list, from the Show drop-down list, select Time 
Adjustments.

6 In the Time and Expense list, select the time item that needs to be adjusted.

7 In the Adjusted Hours field, click the select button.

8 In the Adjusted Hours dialog box, add a new record.

9 In the Hours field, enter the number of hours to add or subtract from the 
submitted number of hours, using a negative number if you want to subtract 
hours, and then click Save. 

NOTE: When you adjust time sheet hours, the total billable hours after 
adjustment must be greater than or equal to 0 and less than or equal to 24 hours.

10 In the Adjusted Hours dialog box, click Close.

The Total Adjustment, Billable Hours, and Billable Fees fields are updated to 
reflect your adjustments.
Version 7.5, Rev. A Siebel Professional Services Automation Guide 157



Time Reporting and Time Sheets

Moving a Time Entry From One Project to Another
Moving a Time Entry From One Project to Another
End users may want to move a time entry from one project to another. This is useful 
in any situation in which presales hours worked become billable after the sale is 
made, as well as in any situation in which time worked was incorrectly associated 
with the wrong project. The following procedure explains how to move a single time 
entry from one project to another, such as from a nonbillable project to a billable 
project. 

To move a time entry from one project to another

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project that is currently associated with the time 
entry.

4 Click the Time and Expense view tab.

5 In the Time and Expense list, from the Show drop-down list, select Time 
Adjustments.

6 Determine whether the Projects field is currently displayed in the Time and 
Expense list; if not, use the Columns Displayed command to add it.

7 In the Time and Expense list, select the time entry that needs to be moved.

8 In the Projects field, click the select button to display the Pick Project dialog box.

9 In the Pick Project dialog box, select the project that the time entry should be 
associated with, and then click OK.
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Moving Multiple Time Entries from One Project to 
Another

It is also possible to move multiple time entries from one project to another at one 
time, but this requires that end users know the exact value they want to place in the 
Project field. The following procedure explains how to do this.

To move multiple time entries from one project to another

1 Complete Step 1 through Step 6 of “Moving a Time Entry From One Project to 
Another.”

2 In the Time and Expense list, hold down the CTRL key as you select multiple 
items to be moved from one project to another.

3 In the Time and Expense list, click the menu button and then click Change 
Records.

4 In the First Field to Change section of the Change Records dialog box, select 
Projects from the Field drop-down list.

5 Also, in the First Field to Change section of the Change Records dialog box, enter 
the exact value for the new project in the Value field.

6 Click OK.
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Viewing a Time Sheet Summary and Time Sheet Summary 
Chart

The Time Sheet Summary view can give end users an overall perspective of hours 
spent on a particular project. This is a read-only view that can be used to provide 
information to anyone who does not need to make time adjustments. The Time 
Sheet Summary Chart shows a graphical representation of the cumulative hours 
worked on a project. The following procedure explains how to display the summary 
and the chart.

NOTE: The Time Sheet Summary Chart does not reflect any adjustments made to 
time submitted.

To view a Time Sheet Summary and Time Sheet Summary Chart for a project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which time sheet information is 
associated.

4 Click the Time and Expense view tab.

5 In the Time and Expense list, from the Show drop-down list, select Time 
Summary.

The information in the Time Summary list shows you the reported hours for 
each time sheet. To view additional information about any time sheet, click the 
Time Sheet Name hyperlink.

6 Scroll down to view the chart. 

By default, the chart shows the hours worked per employee per month, 
displayed as a bar graph with color-coding.

If you want, you can modify the way the data is represented by using the Show 
drop-down boxes to change the information. 

You can also move your cursor over the different bars to get additional 
information on time worked by a particular employee.
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Viewing a Time Sheet Adjustments Chart
The Time Sheet Adjustments chart shows a graphical representation of reported 
time including adjustments made for a selected project. The following procedure 
explains how to display this chart. 

To display the Time Sheet Adjustments Chart

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects List, select the project that has the adjustments you want to view.

4 Click the Time and Expense view tab.

5 From the Show drop-down list in the Time and Expense list, select Time 
Adjustments.

6 Scroll down to view the chart. 

By default, the chart shows the hours worked on the project per employee per 
month, including adjustments, displayed as a bar graph with color-coding.

If you want, you can modify the way the data is represented by using the Show 
drop-down boxes to change the information, and then clicking Go. 

You can also move your cursor over the different bars to get additional 
information on the hours worked by a particular employee, including 
adjustments.
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This chapter explains how to administer and use expense reporting functionality. 
Many procedures in this chapter resemble procedures for time sheets. The end-user 
procedures in this chapter can be used by any Siebel application user who needs to 
report expenses.

Expense reporting helps you streamline the expense reimbursement process by 
eliminating the manual, error-prone, and time consuming task of completing the 
necessary forms. Expense reporting prepares expense reports electronically, which 
helps guarantee that you are reimbursed for your expenses. It routes each expense 
report to the correct approvers, and lets you track the status of expense reports that 
are passing through the approval process. Expense reporting helps you track the 
actual cost of specific projects, and it handles complex currency conversions to 
accommodate business needs that take you out of the country. The expense 
reporting functionality in your Siebel application can be integrated with a back-
office system for final processing and reimbursement of expenses.
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Business Scenario for Expense Reporting
This scenario provides an example of an expense reporting business process 
performed by a Siebel administrator, a consultant, and a consulting manager. Your 
company may follow a different workflow according to its business requirements.

A Siebel administrator at a large consulting company is responsible for setting up 
expense reporting for employees. First he creates additional expense types and 
establishments to meet the special needs of some of the consultants in the company. 
He also changes the existing period type to match the company’s reporting process. 
Next, he must map each expense type to an Actuate report category. This is to make 
sure the correct types are placed in the correct boxes on the Actuate expense report. 
The administrator then must define reporting relationships between end users to 
accommodate the approval process of expense reports. With these relationships he 
must set up limits that determine the maximum expense amount each manager can 
approve per expense report. Any expense report that exceeds the limit is 
automatically routed to another approver, as determined by the reporting 
relationships defined by the Siebel administrator.

The administrator is also responsible for configuring expense reports. He can 
change the name and position of an expense report’s dynamic buttons to meet the 
needs of the company. He can also add new dynamic buttons as needed. Sometimes 
he even has to specify dynamic button inheritance for a new detail view. Finally, he 
must change the trigger for the Submit To field in an expense report when a user 
prefers not to use the value Pending Next Approver as the trigger to change the 
Submit To value.

A number of things must be activated by the Siebel administrator before users can 
successfully work with expense reports. Therefore, the administrator activates Auto 
Gen so that users can automatically submit their reports. He also activates email 
notification and status updating.

One of the company’s typical consultants logs expenses against projects, tasks, or 
activities. Toward the end of a reporting period, she uses the My Expense Diary view 
to enter her expense items. In this view, she also has visibility to the expense items 
that she has not added to any expense reports (unreported items). After entering 
her expenses, she uses the Auto Gen functionality to automatically generate an 
expense report for the current reporting period. After reviewing and editing her 
expense report, she submits it to her manager for review and approval.
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Another way the consultant can enter expenses is to enter them directly against an 
expense report. For example, she can create a new expense report and select the 
desired reporting period. She can then add expense line items to the expense report. 
Before submitting her expense report, there are a number of things she may want 
to do to it. She may need to change the reimbursement currency or change the 
default currency for one or many expense report line items. She can remove an item 
from the report, adjust the billable total, or move one or many expense items from 
one project to another. Once she is satisfied with the expense report, she submits it 
to her manager for review and approval. After submitting the expense report, the 
consultant may find that she made an error and wants to make a change. She can 
recall the expense report from her manager, correct the mistake, and resubmit the 
report.

The company’s consulting manager routinely manages consultants on client 
projects. His responsibilities include reviewing and approving the expenses of his 
subordinates. At the end of the reporting period, he reviews any expense reports 
that require his approval in the Expense Report Approval view. After reviewing one 
of his consultant’s submitted expense reports, he decides whether to approve or 
reject it. If he rejects the expense report, it is returned to the consultant for rework 
and resubmission. If he approves the expense report, and if the expense total is 
within his approval limit, the expense report status is changed to Acceptable. 
However, if the total on an expense report exceeds his approval limits, the expense 
report status is changed to Pending Next Approver and it is forwarded to the next 
level approver for review and approval.

After the expense report has been approved and status is changed to Acceptable, a 
financial administrator processes the expense report for reimbursement. After 
reviewing the expense report, the financial administrator changes the status to 
Acceptable. The financial administrator can also revoke the acceptable expense 
report. A revoked expense report exhibits the same behavior as a rejected expense 
report. It is important to note that this administrative process is likely to be 
automated and connected to a back-office system such as PeopleSoft or SAP and the 
status change may be a data hand-off between the back-office system and the Siebel 
application.

After her expense report has been paid, the consultant updates the status of her 
expense report to Paid to reflect the appropriate fund disbursement stage.
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This is an example of a process an administrator and an end user may follow for 
expense reporting. Your company may follow a different process according to its 
business requirements.

Administrator Procedures
The following administrator procedures describe how to set up several kinds of 
values and reports that users will choose from when working with expense reports, 
how to set up processing parameters such as reporting structures and approval 
limits, how to activate workflows for expense reporting, and how to revoke expense 
reports that do not meet requirements for back-office processing.

1 Create an expense type. For information, see “Creating Expense Types 
(Administrator)” on page 170.

2 Create an establishment. For information, see “Creating Establishments 
(Administrator)” on page 171.

3 Associate an establishment with an expense type. For information, see “Associating 
an Establishment with an Expense Type (Administrator)” on page 172.

4 Add or modify an available period. For information, see “Adding or Modifying 
Available Periods (Administrator)” on page 173.

5 Map an expense type to an Actuate report category. For information, see “Mapping 
Expense Types to Actuate Report Categories (Administrator)” on page 175.

6 Define a reporting relationship. For information, see “Defining Reporting 
Relationships for Expense Reporting (Administrator)” on page 176.

7 Set an approval limit for a user. For information, see “Setting User Approval Limits 
(Administrator)” on page 177.

8 Change the name of a dynamic button. For information, see “Changing the Names 
of Dynamic Buttons for Expense Reports (Administrator)” on page 178.

9 Change the position of a dynamic button. For information, see “Changing the 
Positions of Dynamic Buttons for Expense Reports (Administrator)” on 
page 179.
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10 Add a dynamic button to a new view. For information, see “Adding Dynamic 
Buttons to New Views for Expense Reports (Administrator)” on page 180.

11 Specify the inheritance of a dynamic button for a new detail view. For information, 
see “Specifying Inheritance of Dynamic Buttons for a New Detail View for 
Expense Reports (Administrator)” on page 181.

12 Change the trigger for the Submit To field in an expense report. For information, see 
“Changing the Submit To Field Trigger for Expense Reports (Administrator)” on 
page 183.

13 Activate Auto Gen for expense reports. For information, see “Activating Automatic 
Generation for Expense Reports (Administrator)” on page 184.

14 Activate email notification. For information, see “Activating Email Notification for 
Expense Reports (Administrator)” on page 185.

15 Activate status updating. For information, see “Activating Status Updating for 
Expense Reports (Administrator)” on page 187.

16 Understand currency exchange rates. “Understanding Currency Exchange Rates 
(Administrator)” on page 188.

End-User Procedures
The following end-user procedures describe how to record expenses, how to view 
information related to expenses, and how to create, modify, and process expense 
reports.

1 Record an expense in the My Expense Diary view. For information, see “Recording 
Expenses in the My Expense Diary View” on page 189.

2 Record an expense in the Activities Expenses view. For information, see “Recording 
Expenses in the Activities Expenses View” on page 192.

3 Create an expense report automatically. For information, see “Creating an Expense 
Report Automatically” on page 193.

4 Create an expense report manually. For information, see “Creating an Expense 
Report Manually” on page 194.

5 Change the reimbursement currency. For information, see “Changing the 
Reimbursement Currency” on page 197.
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6 Add expense report line items. For information, see “Adding Line Items to an 
Expense Report” on page 199.

7 Change the default currency for expense line items. For information, see “Changing 
the Default Currency for Expense Line Items” on page 201.

8 Change the currency for a single expense line item. For information, see “Changing 
the Currency for a Single Expense Line Item” on page 202

9 Remove an item from an expense report. For information, see “Removing Items 
from Expense Reports” on page 203.

10 Submit an expense report. For information, see “Submitting an Expense Report” 
on page 204.

11 Recall a submitted expense report. For information, see “Recalling a Submitted 
Expense Report” on page 206.

12 Monitor the status of an expense report. For information, see “Monitoring the 
Status of an Expense Report” on page 207.

13 Print an expense report. For information, see “Printing an Expense Report” on 
page 208.

14 Create an expense report for another end user. For information, see “Creating an 
Expense Report for Another End User” on page 209.

15 Approve or reject an expense report. For information, see “Approving or Rejecting 
Expense Reports” on page 210.

16 Accept or reject expense reports before back-office processing. “Accepting or 
Rejecting Expense Reports Before Back-Office Processing” on page 211.

17 Adjust the billable total for an expense report. For information, see “Adjusting the 
Billable Total for an Expense Report” on page 212.

18 Move an expense item to another project. For information, see “Moving an Expense 
Item to Another Project” on page 213.

19 Move multiple expense items to another project. For information, see “Moving 
Multiple Expense Items to Another Project” on page 214.
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20 View an expense report summary and an expense report summary chart. For 
information, see “Viewing an Expense Report Summary and Expense Summary 
Chart” on page 215.

21 View an expense adjustments chart. For information, see “Viewing an Expense 
Adjustments Chart” on page 216.
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Creating Expense Types (Administrator)
Your Siebel application comes with default expense types, such as Airfare and Car 
Rental. Users select from these expense types in drop-down lists in expense report 
views. You can add more expense types to suit your company’s expense report 
needs. 

For more information on configuring lists of values, see Siebel Applications 
Administration Guide. For information on using lists of values for a global 
deployment, see Global Deployment Guide.

The following procedure explains how to add a new expense type.

To create a new expense type

1 From the application-level menu, choose View > Site Map > Application 
Administration > List of Values.

2 Use standard query procedure to inspect some records with the value of 
EXP_ITEM_TYPE in the Type field, and note the values for each field in a sample 
record.

3 In the List of Values list, add a new record.

4 In the new record, enter EXP_ITEM_TYPE in the Type field.

5 In the Display Value and Language-Independent Code fields, enter the name of 
the new expense type.

6 In the Translate field, make sure the check box is selected.

7 In the Language Name field, click the select button, select the appropriate 
language from the Language Name dialog box, and then click OK.

8 In the Active field, make sure the check box is selected.

9 Complete any additional fields, as needed.

10 Click Clear Cache.

NOTE: After creating an new expense type, you must map it to an Actuate report 
category to make it available for use. For information about how to do this, see 
“Mapping Expense Types to Actuate Report Categories (Administrator)” on 
page 175.
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Creating Establishments (Administrator)
Some expense types are associated with establishments. For example, if the expense 
type is Airfare, possible values for the associated establishment include Air Canada 
and British Airways. Both expense types and establishments are administered as 
lists of values. Each establishment value (EXP_ITEM_ESTAB) must be a child of a 
particular expense type value (EXP_ITEM_TYPE). 

The following procedure explains how to create a new establishment value.

To create a new establishment

1 From the application-level menu, choose View > Site Map > Application 
Administration > List of Values.

2 Query to inspect some records with the value of EXP_ITEM_ESTAB in the Type 
field, and note the values for each field in a sample record.

3 In the List of Values, add a new record.

4 In the Type field, enter EXP_ITEM_ESTAB.

5 In the Display Value and Language-Independent Code fields, enter the name of 
the new establishment type.

6 In the Translate field, make sure that the check box is selected.

7 In the Language Name field, click the select button, select the appropriate 
language from the Pick Language Name dialog box, and then click OK.

8 Complete any additional fields, as needed.
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Associating an Establishment with an Expense Type 
(Administrator)

The following procedure explains how to associate a newly created establishment 
value and its parent expense type value.

To associate an establishment with an expense type

1 From the application-level menu, choose View > Site Map > Application 
Administration > LOV Explorer.

2 In right pane, in the List of Value - Type list, use standard query procedures to 
locate and select a record with the value EXP_ITEM_TYPE in the Type field.

Other types disappear from the left pane.

3 In the left pane, click the plus (+) symbol to the left of EXP_ITEM_TYPE to 
display the Values folder.

4 In the left pane, click the plus (+) symbol to the left of the Values folder to 
display available expense type values.

5 In the left pane, click the plus (+) symbol to the left of the expense type with 
which you want to associate the establishment.

6 In the left pane, click the plus (+) symbol to the left of the Child List of Values 
folder to display the establishments already associated with the selected expense 
type.

7 In the right pane, in the Child List of Values list, add a new record.

8 In the Child List of Values form, complete the following substeps:

a In the Type field, enter EXP_ITEM_ESTAB.

b In the Name field, click the select button to display the Pick Child List of 
Values dialog box.

c Select the establishment you want to associate with the selected expense 
type, and then click OK.

d Click Save.

The selected establishment appears in the left pane as a child value of the 
selected expense value.
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Adding or Modifying Available Periods (Administrator)
When creating an expense report, a user selects the time period the expense report 
covers. Similarly, a user who is filling out a time sheet also selects a time period that 
the time sheet covers. The same time periods are available for expense reports and 
time sheets. By default, the Pick Period dialog box displays only periods of the type 
Week, some of which are supplied with the application. If using a period of type 
Week does not suit your implementation, you can use Siebel Tools to specify a new 
Period Type or to allow users to pick from multiple Period Types.

The Period Type of Week is specified in three places in the repository:

■ Search-Spec of applet 'Period Pick Applet-Open': [Closed Flag] = 'N' AND 
[Period Type] = LookupValue(“PERIOD_TYPE”, “Week”)

■ Time Sheet business component user properties: Period Type = Week 

■ Expense business component user properties: Period Type = Week

If you need a Period Type other than Week, then each of these items must be 
modified in Siebel Tools to indicate the new Period Type. You must use the same 
value for the time sheet period type and the expense period type. 

NOTE: The Auto Gen feature for both time sheets and expense reports uses the 
default period type as defined in the Time Sheet and Expense Report business 
components. Users who create expense reports or time sheets manually can choose 
from the period types that are specified in the search-spec for the applet Period Pick 
Applet-Open.

The following procedure summarizes how to change the period type available for 
expense reports and time sheets, or how to make additional period types available. 
For more information on using Siebel Tools, see Siebel Tools Reference.
Version 7.5, Rev. A Siebel Professional Services Automation Guide 173



Expense Reporting

Adding or Modifying Available Periods (Administrator)
To change or add a period type for expense reports and time sheets

1 In Siebel Tools, modify the search spec of the applet Period Pick Applet-Open.

For example, if you want to allow users to pick from two different period types 
such as Weeks and Months, then the search specification would be as follows: 

[Closed Flag] = 'N' AND ([Period Type] = LookupValue("PERIOD_TYPE", 
"Week") OR [Period Type] = LookupValue("PERIOD_TYPE", "Month"))

2 Modify the value of the business component user property Period Type in the 
Time Sheet business component.

3 Modify the value of the business component user property Period Type in the 
Expense business component. 

4 Recompile the repository. 

NOTE: For more information about administering period types, see Siebel 
Applications Administration Guide.
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Mapping Expense Types to Actuate Report Categories 
(Administrator)

When users work with expense information, they use standard Siebel lists and 
forms. It is also possible to display expense information in a report format that is 
suitable for printing. These reports use the Actuate report server. Some of these 
Actuate expense reports show information from a single expense report record. 
Other Actuate reports summarize information from multiple expense report records.

In order for the Actuate reports to accurately reflect the information from lists and 
forms, you must map each expense type that you create to the appropriate Actuate 
category for the individual and summary reports. This mapping is performed in the 
Application Administration > Expense Types view, in contrast to the definition of 
expense types, which is performed in the Application Administration > List of 
Values view.

The Actuate categories that are available are listed in the Application 
Administration > List of Values view. The categories for individual expense reports 
have the type EXP_ITEM_CAT. The categories for summary expense reports have 
the type EXP_ITEM_SUMCAT. You can add additional categories in the Application 
Administration > List of Values view, but new categories require that you also 
make modifications using Siebel Tools and Actuate software, because new 
categories are not included in the predefined Actuate reports. For more information 
about working with Actuate reports, see Siebel Reports Administration Guide. For 
more information about using Siebel Tools, see Siebel Tools Online Help.

The following procedure explains how to map an expense type to existing Actuate 
categories for individual expense reports and summary expense reports. This 
procedure can be used either to create new mappings for a new expense type, or to 
modify mappings for an existing expense type.

To map an expense type to Actuate expense report categories

1 From the application-level menu, choose View > Site Map > Application 
Administration > Expense Types.

2 In the Expense Type list, add a new record.

3 In the Expense Type field, select an Expense Type from the Expense Type drop-
down list. 
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4 In the Report Category field, select an Actuate category in which you want to 
include the selected expense type, for individual expense reports. 

5 In the Summary field, select an Actuate category in which you want to include 
the selected expense type, for summary expense reports.

Defining Reporting Relationships for Expense Reporting 
(Administrator)

The reporting relationships you define for your Siebel application are a part of the 
infrastructure for approving expense reports. When a user creates an expense 
report, the value of the Submit To field defaults to the User ID of the person to 
whom that user reports. If the reporting structure has not been defined, the user 
cannot save the expense report or use Auto Gen for transferring expense diary 
entries into the current report.

Reporting relationships apply to both expense reports and time sheets. If you have 
already defined reporting relationships for time sheets, those definitions fulfill the 
requirements for expense reports. If you have not yet defined reporting relationships 
for either time sheets or expense reports, see “Defining Reporting Relationships 
(Administrator)” on page 121 for the correct procedure. This procedure explains 
how to set the reporting relationship between a subordinate and the supervisor or 
manager to whom the subordinate reports. This procedure must be followed for 
every user who is allowed to submit expense reports. 
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Setting User Approval Limits (Administrator)
Based on the reporting structure of your organization, you must set up limits that 
determine the maximum expense amount each manager can approve. Any expense 
report that exceeds the limit is automatically routed to another approver, as 
determined by the reporting relationships you have defined. The following 
procedure explains how to set the approval limit amount for a particular approver.

To set an expense report approval limit

1 From the application-level menu, choose View > Site Map >User 
Administration >Employees.

2 In the Employees list, select the employee for whom the approval limit will be 
set.

3 In the Expense Approval Limit field, enter the approval limit.
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About Dynamic Buttons (Administrator)
A dynamic button is a button whose availability depends on the currently selected 
view. It is activated based on the state of the currently selected record, as defined 
in the Siebel State Model. For information about using the State Model, see Siebel 
Business Process Designer Administration Guide. 

Various Expense Report views in your Siebel application contain dynamic buttons. 
The buttons are used in the expense report approval process. By default, these 
buttons are labelled Submit, Approve, Accept, Paid, Recall, and Reject. You can 
configure the following properties of these dynamic buttons:

■ Name that is displayed on each button

■ Left-to-right sequence in which buttons are displayed, when two or more 
dynamic buttons are displayed together

■ Views that display dynamic buttons

This section explains how to make each of these configuration changes. Because 
dynamic buttons are managed as list of values (LOV) entries, you can reconfigure 
them without using Siebel Tools. 

NOTE: Standard dynamic button configurations are included in the seed data that 
comes with your Siebel application. If you do not use Siebel seed data in your 
implementation, you must either recreate the standard dynamic button 
configurations or load the configurations from the seed data into your system. 

Changing the Names of Dynamic Buttons for Expense Reports 
(Administrator)
The following procedure explains how to change the name that is displayed on a 
dynamic button.

To change the name of a dynamic button for expense reports

1 From the application-level menu, choose View > Site Map > Applications 
Administration > List of Values.

2 In the List of Value list, click Query.
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3 Enter *DYN* in the Type field, and then click Go.

The dynamic buttons for expense reports have the Type field set to 
EXPRPT_DYNAMIC_BT.

4 Select the dynamic button that has a name you want to change.

5 Enter the new name in the Display Value field and the Language-Independent 
Code field.

6 In the List of Values list, click the menu button, and then click Save Record.

7 Click Clear Cache. 

This step reloads dynamic button settings into the server cache. When this 
process is complete, the modified dynamic button is available for use.

Changing the Positions of Dynamic Buttons for Expense Reports 
(Administrator)
The following procedure explains how to change the left-to-right sequence in which 
dynamic buttons are displayed, when two or more dynamic buttons are displayed 
together.

To change the relative positions of dynamic buttons for expense reports

1 From the application-level menu, choose View > Site Map > Applications 
Administration > List of Values.

2 In the List of Values list, click Query.

3 Enter *DYN* in the Type field, and then click Go.

The dynamic buttons for expense reports have the Type field set to 
EXPRPT_DYNAMIC_BT.

4 Find the dynamic buttons that you want to place in a new sequence.
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5 In the Order field, enter a new sequence number for each button you are placing 
in a new sequence.

NOTE: If buttons have identical sequence numbers, they will be displayed in 
alphabetical order.

6 In the List of Values list, click the menu button, and then click Save Record.

7 Click Clear Cache. 

This step reloads dynamic button settings into the server cache. After this 
process is complete, the applicable Expense Report views display the buttons in 
their new order.

Adding Dynamic Buttons to New Views for Expense Reports 
(Administrator)
The following procedure explains how to display the dynamic buttons for expense 
reports in a new view. If you configure new views, you may want the dynamic 
buttons to appear there.

To add dynamic buttons for expense reports to new views

1 From the application-level menu, choose View > Site Map > Applications 
Administration > List of Values.

2 Display the High and Low columns using Columns Displayed. For information 
about using Columns Displayed functionality, see Fundamentals.

3 In the List of Values list, click Query.

4 Enter *DYN* in the Type field, and then click Go.

The dynamic buttons for expense reports have the Type field set to 
EXPRPT_DYNAMIC_BT.

5 Select a button that you want to add to one or more new views.
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6 In the Low field, enter the names of the new views to display this button, 
preceding each view name and following the final view name with the percent 
sign (%). 

For example, if you want to add the selected button to views NewViewA and 
NewViewB, you would enter %NewViewA%NewViewB%, without intervening 
spaces.

7 In the List of Values list, click the menu button, and then click Save Record.

NOTE: Repeat Step 5 on page 180 through Step 7 for each additional button that 
you want to display in new views.

8 Click Clear Cache. 

This step reloads dynamic button settings into the server cache. After this 
process is complete, the new views you specified display the dynamic buttons 
you specified.

Specifying Inheritance of Dynamic Buttons for a New Detail View 
for Expense Reports (Administrator)
LOV records of type EXPRPT_DYNAMIC_BT are modified in the dynamic button 
procedures discussed so far. LOV records of type EXPRPT_DETAIL_VIEWS also 
affect dynamic buttons in expense reports. EXPRPT_DETAIL_VIEWS records specify 
the views that inherit dynamic buttons from a related view. 

For example, if you navigate to the My Expense Reports view, Submit and Recall 
buttons are displayed on both the Expense Reports list and the More Info form. If 
you click the Line Items view tab, an Expense Report form and a Line Items list 
appear. The Expense Report form displays Submit and Recall buttons that it has 
inherited from the My Expense Reports view. This inheritance is specified by 
placing the value “%Expense Report Line Items Summary View%Expense Report 
Line Items Detail View%” in the description field of an EXPRPTS_DETAIL_VIEW 
LOV record. The following procedure explains how to specify dynamic button 
inheritance for a new detail view.
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To specify detail views to inherit dynamic buttons for expense reports

1 From the application-level menu, choose View > Site Map > Applications 
Administration > List of Values.

2 Display the Description column using Columns Displayed. For information 
about using Columns Displayed functionality, see Fundamentals.

3 In the List of Values list, click Query.

4 Enter EXPRPT_DETAIL_VIEWS in the Type field, and then click Go.

5 Select an existing EXPRPT_DETAIL_VIEWS record.

6 In the Description field, enter the names of the views that you want to have 
inherit dynamic buttons from related views, preceding each view name and 
following the final view name with the percent sign (%). 

For example, if you want NewViewC and NewViewD to inherit dynamic buttons 
from related views, you would enter %NewViewC%NewViewD%, without 
intervening spaces.

7 In the List of Values list, click the menu button, and then click Save Record.

8 Click Clear Cache. 

This step reloads dynamic button settings into the server cache. After this 
process is complete, the views you specified inherit dynamic buttons from 
related views. 
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Changing the Submit To Field Trigger for Expense 
Reports (Administrator)

By default, Siebel Professional Services Automation uses the Pending Next 
Approver expense report Status value as a trigger to change the value in the Submit 
To field from the current approver’s user ID to the user ID of the next approver. If 
you prefer not to use the value Pending Next Approver as the trigger to change the 
Submit To value, you must complete several tasks. The following procedure briefly 
explains how to change the trigger for the Submit To field.

NOTE: A similar procedure applies if you want to change the trigger for the Submit 
To field for time sheet approvals. Because you must use Siebel Tools and recompile 
your .srf file for either procedure, you may want to combine the time sheet and 
expense report procedures, so you can recompile only once. For information about 
the time sheet procedure, see “Changing the Trigger for the Submit To Field for Time 
Sheets (Administrator)” on page 128.

To change the trigger value for the Submit To field for expense reports

1 Locate the List of Values record that has Type set to EXP_STATUS and Display 
Value set to Pending Next Approver, and replace both the Display Value and the 
Language-Independent Code value with the value you have chosen as the 
trigger.

2 Modify the Update Expense Status workflow to replace Pending Next Approver 
with the value you have chosen as the trigger.

3 Modify the Expense Report Approval state model to replace Pending Next 
Approver with the value you have chosen as the trigger.

4 In Siebel Tools, make the following changes:

a Locate the Expense business component.

b Add a business component User Property with Name field set to Next 
Approver Status and Value field set to the value you have chosen as the 
trigger.

c Recompile the .srf file.
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Activating Automatic Generation for Expense Reports 
(Administrator)

The Auto Gen feature lets each user transfer multiple line items of expense 
information from the My Expense Diary view to a current expense report, by means 
of a single command. The following procedure explains how to make Auto Gen 
available to end users.

To activate Auto Gen for expense reports

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 In the Workflow Processes list, click Query.

3 In the Name field, enter *AutoGen*, and then click Go.

4 In the Workflow Processes list, select the Expense Report AutoGen record with 
the highest value in the Version field, and then click Revise.

A new record is created with a status of In Progress and a higher version number.

5 In the Activation Date/Time field, enter a date and time after which you want 
Auto Gen to be available. 

If no value is specified in this field, this functionality becomes available when 
you select the workflow and click Activate, as described later in this procedure.

6 In the Expiration Date/Time field, enter a date and time after which you want 
Auto Gen to be unavailable.

If no value is specified in this field, the Auto Gen capability remains available 
until manually deactivated.

7 In the Workflow Processes list, click Activate.

If the process is successful, the Status field changes from In Progress to Active.
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Activating Email Notification for Expense Reports 
(Administrator)

The following procedure explains how to activate the workflow that provides 
automatic email notification during the expense report approval process. These 
messages notify expense report approvers when they need to review particular 
expense reports and provide expense report submitters with updates on the 
progression of their expense reports through the approval process. This procedure 
assumes that your Siebel Communications Server has already been set up and 
configured, as described in Siebel Communications Server Administration Guide.

To activate email notification for expense reports

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 In the Workflow Processes list, click Query.

3 In the Name field, enter Expense Report Process, and then click Go.

4 In the Workflow Processes list, select the Expense Report Process record with the 
highest value in the Version field, and then click Revise.

A new record is created with a status of In Progress and a higher version number.

5 In the Activation Date/Time field, enter a date and time after which you want 
notification to be available. 

If no value is specified, the notification functionality becomes available when 
you select the workflow and click Activate, as described later in this procedure. 
Make a note of the value you specified.

6 In the Expiration Date/Time field, enter a date and time after which you want 
notification to be unavailable.

If no value is specified, notification remains available until manually 
deactivated. Make a note of the value you specified.
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7 Complete the following substeps to verify associated workflow policy settings:

a From the Show drop-down list, select Workflow Policies.

b In the Policies List list, query to locate the following policies:

❏ Send Expense Report Approval Email policy

❏ Send Expense Report Approval Email to New Approver policy

c Make sure that the Activation and Expiration settings for these policies match 
the Activation Date/Time and Expiration Date/Time settings you specified in 
Step 5 and Step 6 on page 185.

d From the Show drop-down list, select Workflow Processes.

8 In the Workflow Processes list, reselect the Expense Report Process record that 
has a status of In Progress, and click Activate.

The Status field changes from In Progress to Active.
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Activating Status Updating for Expense Reports 
(Administrator)

The following procedure explains how to activate the workflow that updates an 
expense report status of Approved to a status of Acceptable or Pending Next 
Approver, depending on whether or not the most recent approver is authorized to 
approve the amount of the expense report.

To activate status updating for expense reports

1 From the application-level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

2 In the Workflow Processes list, click Query.

3 In the Name field, enter Update Expense Status, and then click Go.

4 In the Workflow Processes list, select the Update Expense Status record with the 
highest value in the Version field, and then click Revise.

A new record is created with a status of In Progress and a higher version number.

5 In the Activation Date/Time field, enter a date and time after which you want 
status updating to be available. 

If no value is specified, this functionality becomes available when you select the 
workflow and click Activate, as described later in this procedure. 

6 In the Expiration Date/Time field, enter a date and time after which you want 
status updating to be unavailable.

If no value is specified, status updating remains available until manually 
deactivated.

7 In the Workflow Processes list, click Activate.

The Status field changes from In Progress to Active.
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Understanding Currency Exchange Rates (Administrator)
An expense report is automatically assumed to be reimbursed in the default 
currency, which is the currency of the user’s country. However, a user may need to 
be reimbursed in a different currency or may have expense report line items in 
different currencies.

In these cases, Siebel applications automatically display an exchange rate. Whether 
or not users can change the rate that is automatically displayed depends on whether 
the expense was incurred in the currency of a member country in the European 
Monetary Union (EMU) and whether the reimbursement will be in an EMU 
currency. Details about exchange rate behavior are shown in Table 5. for 
information about creating or adding currencies, see Siebel Applications 
Administration Guide.

Table 5. Exchange Rate Behavior for Expense Reports

Incurred Currency
Reimbursement 
Currency

Exchange Rate 
Provided by 
Application?

Exchange Rate 
Changeable by User? Comments

EMU EMU Yes No The currencies have a fixed 
exchange rate through the 
Euro, and use a conversion 
process called 
triangulation.

Not EMU EMU Yes Yes Users can specify a 
nondefault exchange rate.

EMU Not EMU Yes Yes Users can specify a 
nondefault exchange rate.

Not EMU Not EMU Yes Yes Users can specify a 
nondefault exchange rate.

Any currency Same as 
incurred 
currency

Yes; the exchange 
rate is 1

No Because the two currencies 
are the same, users cannot 
change the exchange rate.
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Recording Expenses in the My Expense Diary View
My Expense Diary is a view in which end users can log expenses against projects, 
tasks, or activities. 

The following procedure explains how to record an expense using the My Expense 
Diary view.

To record an expense using the My Expense Diary view

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Diary.

3 In the My Expense Diary list, add a new record.
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4 Complete the fields in the My Expense Diary list and in the More Info form. 
Some fields are described in the following table.

Field Comments

Account Customer or potential customer organization associated with the 
expense.

Amount Amount of money spent.

Activity Activity that required the expenditure.

Billable When selected, indicates that the expense can be billed to the 
associated account.

Class General category of expense. Typical values include Client 
Billable, Client Investment, and Internal. Available values are set 
in the PROJECT_CLASS list of values. 

Converted Amount Amount of the expense multiplied by the exchange rate. This 
field is read-only.

Contacts Contacts associated with the expense. A typical use of this field 
might be to record the clients who were present at a dinner for 
clients.

Distance When Type is set to Mileage, the Distance field displays the 
number of miles driven.

Employees Employees associated with the expense. A typical use of this field 
might be to record the employees who were present at a dinner 
for clients.

End Final day on which the expense was incurred. Defaults to the 
value of the Start field.

Opportunity Sales opportunity associated with the expense.

Other Taxes Hotel taxes other than sales tax, such as state or local taxes.

Rate When Type is set to Mileage, the Rate field displays the charge 
per unit of distance. This field is read-only. This value is set in 
the Expense Reports view of the User Preferences screen. 
Depending on your implementation, this view may be visible 
only to administrators.

Room Rate When Type is set to Hotel, the Room Rate field displays charge 
per unit of time for a hotel room.
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NOTE: To record additional expense items, repeat Step 3 on page 189 and Step 4 
on page 190 of this procedure.

Route When Type is set to Mileage, the Route field displays information 
about the route or routes driven.

Reimbursable When selected, indicates that the expense should be reimbursed. 
When cleared, indicates that the expense was personal (such as 
renting a movie during a hotel stay) and should not be 
reimbursed. Defaults to selected.

Start First day on which the expense was incurred. Defaults to today’s 
date.

Task Task associated with the expense.

Tax When Type is set to Hotel, the Tax field records taxes paid on 
hotel accommodation charge.

Type Kind of expense incurred.

Field Comments
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Recording Expenses in the Activities Expenses View
The Activities Expenses view lets end users log expenses incurred for individual 
activities. Expenses recorded in the Activities Expenses view are also visible in the 
My Expense Diary view, until they are included in an expense report for a specific 
period. 

The following procedure explains how to record an expense for a specific activity.

To record an expense using the Activities Expenses view

1 Navigate to the Activities screen.

2 From the Show drop-down list, select My Activities. 

3 In the Activities list, select the activity for which you want to record an expense.

4 Click the Expenses view tab.

5 In the Expenses list, add a new record.

6 Complete the fields. For a description of the fields available, see “Recording 
Expenses in the My Expense Diary View” on page 189.
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Creating an Expense Report Automatically
The following procedure explains how to generate an expense report that 
automatically includes expenses that meet each of the following conditions:

■ Expense is listed in the My Expense Diary view or the Activities Expenses view

■ Expense is for a date that falls within the current reporting period or a previous 
reporting period (not a future period)

■ Expense has not yet been included in a previous expense report

The expenses that meet these conditions are put into an expense report for the 
current reporting period, regardless of when each expense was incurred. This is 
called Auto Gen functionality. This procedure can be used from anywhere in the 
Siebel application. For information about creating an expense report manually, see 
“Creating an Expense Report Manually” on page 194.

To create a current expense report automatically

■ From the application-level menu, select File > Auto > Expense Report.

If you already have an expense report for the current period, and if its status is 
set to In Progress, then a workflow moves your expense diary items to the line 
items section of your existing report. 

If you do not yet have an expense report for the current period, or if you have 
one, but its status is not set to In Progress, then a workflow creates a new 
expense report and moves the items in your expense diary to the line items 
section of the new expense report. 

NOTE: Once you have created an expense report using Auto Gen, you may find 
that some expense items do not belong in that expense report. In that case, you 
can move the inappropriate items back to your expense diary. For more 
information, see “Removing Items from Expense Reports” on page 203. When 
you have submitted the current expense report, you can repeat the Auto Gen 
procedure to place the remaining diary items in a new expense report, which 
will also be for the current period. If necessary, you can change the period for 
any unsubmitted expense report, including expense reports created by Auto 
Gen.
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Creating an Expense Report Manually
In some situations, end users may find it more convenient to create an expense 
report manually, rather than automatically. For example, the organization might 
require separate expense reports for expenses incurred in different time periods, or 
end users might need to report multiple expenses in a currency other than the one 
that the organization uses by default. When working with multiple currencies, it 
might be quicker to change the default currency for an entire expense report and 
record the expenses directly into the report as line items, rather than setting the 
currency for each individual line item, as must be done in the My Expense Diary 
view.

The following procedure explains how to create an expense report manually. This 
procedure sets up the framework of the expense report. For instructions on how to 
add line items to the newly created report, see “Adding Line Items to an Expense 
Report” on page 199.

To create an expense report manually

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.

3 Click the More Info view tab.

4 In the More Info form, add a new record.
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5 Complete the necessary fields. Some fields are described in the following table.

Field Comments

Amount Paid Amount of the reimbursement. Typically, the value for this 
field is supplied by a back-office system. This field is also 
where the reimbursement currency for the report is set.

Cash Advance Lets you record any cash advance you received. This amount 
is subtracted from the total amount owed to you. The Cash 
Advance value is subtracted from the Expense Report Total to 
get the Reimbursable Amount.

Class General category of expense. Typical values include Client 
Billable, Client Investment, and Internal. Available values are 
set in the PROJECT_CLASS list of values.

Currency Default currency for line items in this expense report. 
Defaults to the currency of the user’s organization.

Description Text field for describing the expense report as a whole. 

End Last day of the expense reporting period. 

Expense Report # A unique identifier for this expense report. Automatically 
populated.

Expense Report Total Sum of the line items in the report, including both 
reimbursable and nonreimbursable items, expressed in the 
reimbursement currency.

Name Name for the expense report. 

Pay To User ID of the person to be reimbursed.

Period Time period during which the expenses are being reported. 
The expenses may or may not have been incurred in this 
period.

Prepared By Person who prepared the expense report.

Reimbursable When selected, new line items for the current expense report 
default to reimbursable.

Reimbursable Amount Sum of reimbursable line items. Automatically calculated.

Start First day of the expense reporting period.
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NOTE: For information about adding line items to the expense report, see 
“Adding Line Items to an Expense Report” on page 199.

Status Indicates the stage the expense report has reached in the 
approval process. If the status is In Progress, the report can be 
edited. 

Submitted By User ID of the person who incurred the expenses.

Submit To Required. The User ID of the person who should approve the 
expense report. Normally defaults to the User ID of the person 
to whom you report, but can be changed, if, for example, that 
person is unavailable for an extended period.

Field Comments
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Changing the Reimbursement Currency
By default, when an expense report is created, the reimbursement currency is set to 
the currency of the end user’s parent organization. The symbol for this currency 
appears in the following locations:

■ Currency Code field of the pop-up form accessed from the expense report 
Amount Paid field

■ Expense Report Total field for the expense report

■ Reimbursable Amount field for the expense report

■ Converted Amount field for the line items of the expense report

End users can change the reimbursement currency for any individual expense 
report that they create and that has a status of In Progress, as described in the 
following procedure. 

To change the currency for reimbursement

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select the appropriate view.

3 Create a new expense report or select an existing expense report that has a status 
of In Progress.

4 If you have not already done so, navigate to the Expense Reports > My Expense 
Reports view, and select the expense report you want to work with.

5 In the Amount Paid field, click the select button to display a pop-up form 
containing a Currency Code field and an Amount field. 

6 In the Currency Code field, click the select button to display the Pick Currency 
Code dialog box.
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7 In the dialog box, select the currency you want used for your reimbursement, 
and then click OK.

The dialog box closes, and your selection is displayed in the Currency Code field 
of the pop-up form. The corresponding currency symbol appears in the Expense 
Report Total field and the Reimbursable Amount field. If either of these fields 
contain nonzero values, the values are automatically converted to the monetary 
equivalent in the newly chosen currency. 

8 Click outside the pop-up form to close it.
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Adding Line Items to an Expense Report
Each expense report must include expense line items. The use of the Auto Gen 
feature automatically moves My Expense Diary items or Activity Expense items into 
an end user’s own expense report. End users can also add line items directly to an 
expense report, either for themselves or for another person. The following 
procedure explains how to add a line item to an expense report.

To add a line item to an existing expense report

1 If you have not already done so, navigate to one of the following views.

■ If the expense report is for yourself, navigate to the Expense Reports > My 
Expense Reports view.

■ If the expense report is for another person, navigate to the Expense Reports > 
Assistant’s Expense Reports view.

2 Select the expense report to which you want to add a line item.

3 Click the Line Items view tab.

4 In the Line Items list, add a new record.

5 Complete the fields. Some fields are described in the following table.

Field Comments

Amount Amount of money spent on the item. If you type in an amount 
directly, the units are assumed to be those specified in the 
expense report’s Currency field. To specify a different currency, 
click in the Amount field to display the select button, and then 
click the select button to display a pop-up form in which 
currency and exchange date can be specified.

Converted Amount Reimbursement currency equivalent to the Amount value. For 
information about setting the reimbursement currency, see 
“Changing the Reimbursement Currency” on page 197.

Description Description of the item.

End Last day on which there was a charge for the item.
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6 If the line item you are adding concerns car mileage or hotel expenses, or if you 
want to record more details about a line item of another type, scroll down until 
the Expense Item Detail form is visible, and then click the show more button.

7 Complete any desired additional fields. For descriptions of the available fields, 
see “Recording Expenses in the My Expense Diary View” on page 189.

Exchange Rate Value by which the Amount is multiplied to obtain the Converted 
Amount.

Reimbursable When selected, this field indicates that the expense item should 
be reimbursed. When cleared, this field indicates that the 
expense item was a personal expense that should not be 
reimbursed, such as renting a movie during a hotel stay.

Start First day on which there was a charge for the item. For the first 
record created, the Start field defaults to the first business day of 
the period. For subsequent records, the Start field defaults to the 
start value of the selected record. This reduces time spent 
entering items chronologically.

Type Kind of expense incurred. If you choose Mileage or Hotel, several 
fields related to the chosen value become available in the 
Expense Item Detail form.

Field Comments
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Changing the Default Currency for Expense Line Items
If end users need to report multiple expenses that were incurred in currency other 
than their reimbursement currency, they can change the default currency for line 
items within an individual expense report. This default is set using the Currency 
field for the expense report. The value of the Currency field does not affect the kind 
of currency that is used in the Expense Report Total field and the Reimbursable 
Amount fields of the report. The following procedure explains how to change the 
default currency for line items within an expense report.

To change the default currency for line items in an expense report

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select the appropriate view.

3 Create a new expense report or select an existing expense report that has a status 
of In Progress.

4 Click the More Info view tab.

5 In the Currency field, click the select button to display the Pick Currency Code 
dialog box.

6 In the dialog box, select the currency you want to use as the default for line items 
in the current expense report, and then click OK.

The dialog box closes, and the currency code appears in the Currency field of the 
More Info form.

7 Click the Line Items view tab.

8 In the Line Items list, add a new record.

9 In the Type field, select an expense type for the line item you are creating.

10 In the Amount field, enter the amount of money spent for this line item, and 
then click in any other field.

The currency symbol you chose in Step 6 of this procedure automatically 
appears in the Amount field for the line item.
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Changing the Currency for a Single Expense Line Item
If end users have a small number of expenses in a different currency than the 
currency used for most expenses in a report, they can use the following procedure 
to change the currency for any individual line item, rather than changing the default 
currency for the report.

To change the currency for a single expense line item

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select the appropriate view.

3 Create a new expense report or select an existing expense report that has a status 
of In Progress.

4 Click the Line Items view tab.

5 In the Line Items list, create a new line item or select an existing line item.

6 In the Amount field, click the select button to display a pop-up form containing 
Currency Code, Exchange Date, and Amount fields.

7 In the Currency Code field, click the select button to display the Pick Currency 
Code dialog box.

8 Select the currency in which the expense was incurred, and then click OK to 
close the dialog box.

9 Enter the amount of the expense in the Amount field, and then click outside the 
pop-up form to close it. 

10 Complete any remaining line items fields, as needed. For more information 
about adding line items, see “Adding Line Items to an Expense Report” on 
page 199.
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Removing Items from Expense Reports
The following procedure explains how to remove a line item from an expense report 
and return it to the My Expense Diary view. 

NOTE: This procedure requires that the status of the selected expense report be In 
Progress.

To remove an item from an expense report

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.

3 In the Expense Reports lists, select the expense report from which you want to 
remove an item.

4 Click the Line Items view tab.

5 In the Line Items list, select the item that you want to remove from the report 
and return to your expense diary.

6 In the Line Items list, click the menu button, and then click Unreport.

NOTE: Although the expense item is no longer associated with this expense 
report, it is not deleted. To see the expense item, go to the My Expense Diary 
view.
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Submitting an Expense Report
After end users create an expense report and add line items, they can edit it as 
necessary up until they submit the report for approval. 

When end users submit an expense report, the application automatically routes it 
to whoever is specified in the Submit To field for evaluation. By default, the value 
in the Submit To field is the User ID of the end user’s manager. If the expense report 
should be submitted to someone other than the end user’s manager (such as the 
team leader or project manager), the end user can change the value either before or 
after they submit the expense report—the Submit To field remains editable after the 
expense report is submitted, as do the Private Comments and Public Comments 
fields.

NOTE: If the Siebel administrator activated email notification for expense reports, an 
email is sent when end users change the Status field to Submitted to notify the 
expense report approver that a report needs to be approved. For more information 
about activating email notification see, “Activating Email Notification for Expense 
Reports (Administrator)” on page 185.

Each submitted report is either approved or rejected by the person specified in the 
Submit To field. If that person approves the report, the application checks whether 
the total amount of the report requires further approval, and, if so, the report is 
routed to the next approver. As soon as the report is approved by someone who is 
authorized to approve that amount, the report is routed to the financial department, 
so the end user can be reimbursed for the amount requested. 

To submit an expense report

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.
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3 In the Expense Reports list, select the report you want to submit for approval, 
and then click Submit.

The value of the Status field changes to Submitted, and an email message is 
automatically sent to the person who is specified in the Submit To field, 
notifying them that there is an expense report for them to approve.

If your expense report is rejected or revoked, you need to go back into the 
Expense Reports screen, click Recall to change the status from Rejected or 
Revoked to In Progress, make the necessary changes, and then resubmit it.
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Recalling a Submitted Expense Report
After submitting an expense report, end users may find that they need to make a 
correction to it, or they may be notified that an approver has rejected or revoked the 
expense report and is requiring that changes be made to it. If the current status of 
an end user’s expense report is Submitted, Rejected or Revoked, they can use the 
Recall button to change the status back to In Progress, which allows them to make 
the necessary changes. When the end user has corrected the report, they can 
resubmit it, using the same procedure as the first time. For more information, see 
“Submitting an Expense Report” on page 204.

The following procedure explains how to recall an expense report that has already 
been submitted.

To recall a submitted expense report

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.

3 In the Expense Reports list, select the submitted expense report that you want 
to recall.

The status of the selected report should be either Submitted or Rejected.

4 In the Expense Reports list, click Recall.

The status of the report changes to In Progress.
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Monitoring the Status of an Expense Report
After an expense report has been submitted, the Siebel application uses email to 
notify both the end user and the end user’s manager of its progress.

For example, when end users submit their expense report to their manager, the 
manager receives an email notification that there is an expense report waiting for 
approval. 

Likewise, when the manager has approved or rejected the expense report, the end 
user receives email notification. End users can also see their submitted and 
approved expense reports in the My Expense Reports view, where the current stage 
of the approval process is shown by the Status field. The following procedure 
explains how to view the approval history of a particular expense report.

To view the approval history of an expense report

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.

3 In the Expense Reports list, select the report for which you want to view the 
approval history.

4 Click the Approvals view tab.
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Printing an Expense Report
The following procedure explains how to print an expense report. The printed 
version of an expense report has a different format than the lists and forms end 
users use when creating or approving expense reports.

To print an expense report

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Expense Reports list, locate the expense report you want to print.

4 From the application-level menu, choose View > Reports.

5 In the Reports dialog box, from the Select a Report drop-down list, select 
Expense Reports.

6 Click Run Now.

The application displays your expense report in the Siebel Report Viewer 
window.

7 In the Siebel Report Viewer window, click the Print button.

The report prints to your default printer.
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Creating an Expense Report for Another End User
The following procedure explains how to create an expense report, manually, for 
another end user of the application. A typical use of this procedure would be for an 
assistant to prepare an expense report for an executive. This procedure does not 
require that a formal reporting relationship exist—any end user who has access to 
the Assistant’s Expense Reports view can prepare an expense report for another end 
user.

To create an expense report for another end user

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select Assistant’s Expense Reports.

3 In the More Info form, click the show more button, and then add a new record.

4 In the Submit To field, either enter the User ID of the person who should review 
and approve this expense report, or click the select button and complete the 
following substeps:

a In the Pick Employee dialog box, use query or find to locate and select the 
record that lists the person who should review and approve this expense 
report.

b Click OK to close the dialog box and place the selected User ID in the Submit 
To field.

5 In the Pay To field, either enter the User ID of the person who incurred the 
expenses, or click the select button and complete the following substeps:

a In the Pick Owned By dialog box, use query or find to locate and select the 
record that lists the person who incurred the expenses.

b Click OK to close the dialog box and place the selected User ID in the 
Submitted By field.

6 Complete the remaining fields as needed. For descriptions of the fields available, 
see “Creating an Expense Report Manually” on page 194.

NOTE: For information about adding line items to the expense report, see 
“Adding Line Items to an Expense Report” on page 199.
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Approving or Rejecting Expense Reports
End users designated as approvers of expense reports for specific employees or 
specific projects receive an email message notifying them each time that an expense 
report is ready for their review.

If an end user approves an expense report for an amount within their approval limit, 
the report is forwarded to the finance professional, who reviews it before it is passed 
to the back-office system for reimbursement.

If an end user approves an expense report for an amount larger than their approval 
limit, the report is forwarded to someone with a larger approval limit, typically that 
end user’s own manager.

If an end user rejects an expense report, the person who submitted the report can 
recall it, modify it, and resubmit it.

NOTE: End users can approve or reject multiple expense reports at one time. 

The following procedure explains how to approve or reject expense reports.

To approve or reject expense reports

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select Expense Report Approval.

3 In the Expense Reports list, select one or more expense reports to approve or 
reject.

4 In the Expense Reports list, click either Approve or Reject.

The value of the Status field changes to Approved or Rejected.
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Accepting or Rejecting Expense Reports Before Back-
Office Processing

If the Siebel application is integrated with the organization’s back-office processing 
system, the final step of the expense report approval process is for a finance 
professional to accept or reject an expense report before it is passed to the back-
office system for processing. The following procedure explains how to accept or 
reject an expense report that has been approved by the appropriate managers. Such 
an expense report has the Status field set to Acceptable. This procedure can be 
performed by any end user who has access to the Approved Expense Reports view.

To accept or reject an expense report before back-office processing

1 From the application-level menu, choose View > Site Map > Expense
Reports > Approved Expense Reports.

2 In the Expense Reports list, select one or more expense reports that you want to 
accept or reject for back-office processing.

3 In the Expense Reports list, click Accept or Reject, according to your choice.

The value of the Status field changes to Accepted or Revoked, respectively.
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Adjusting the Billable Total for an Expense Report
From time to time, end users may need to adjust an expense report that has been 
submitted to them for approval. Ordinarily, end users can reject an expense report 
that includes errors and have the person who prepared the report correct the error. 

On some occasions, however, the expense report may be correct, but the end user 
may want to adjust the amount to be billed as a courtesy to the customer. End users 
can make an adjustment to the Billable Total of an expense report at any time before 
the invoice associated with the expense has its status set to Billed. The following 
procedure explains how to adjust the Billable Total for an expense report line item.

To adjust the billable total for an expense report line item

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the expense report is associated.

4 Click the Time and Expense view tab.

5 In the Time and Expense list, from the Show drop-down list, select Expense 
Adjustment.

6 In the Time and Expense list, select the expense line item that needs to be 
adjusted.

7 In the Adjustment field, click the select button.

8 In the Adjusted Amount dialog box, click New.

9 In the Amount field, adjust the amount as necessary, complete other desired 
fields, and then click Save.

10 In the Adjusted Amount dialog box, click Close.

The Total Adjustment and Billable Total fields are updated to reflect your 
adjustments.
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Moving an Expense Item to Another Project
The following procedure explains how to move an expense line item from one 
project to another, such as from a nonbillable project to a billable project. This is 
useful in any situation in which presales expenses become billable after the sale is 
made, as well as in any situation in which an expense item was incorrectly 
associated with the wrong project.

To move an expense item from one project to another

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project that is currently associated with the 
expense item.

4 Click the Time and Expense view tab.

5 In the Time and Expense list, from the Show drop-down list, select Expense 
Adjustments.

6 Determine whether the Projects field is currently displayed in the Time and 
Expense list; if not, use the Columns Displayed command to add it.

7 In the Time and Expense list, select the item that needs to be moved.

8 In the Projects field, click the select button to display the Pick Project dialog box.

9 In the Pick Project dialog box, select the project that the expense should be 
associated with, and then click OK.
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Moving Multiple Expense Items to Another Project
It is also possible to move multiple expense items from one project to another at one 
time, but this requires that end users know the exact value they want to place in the 
Project field. The following procedure explains how to do this. 

To move multiple expense items from one project to another

1 Follow Step 1 through Step 6 of “Moving an Expense Item to Another Project” 
on page 213.

2 In the Time and Expense list, hold down the CTRL key as you select multiple 
items to be moved from one project to another.

3 In the Time and Expense list, click the menu button and select Change Records.

4 In the First Field to Change section of the Change Records dialog box, select 
Projects from the Field drop-down list.

5 In the First Field to Change section of the Change Records dialog box, enter the 
exact value for the new project in the Value field.

6 Click OK.
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Viewing an Expense Report Summary and Expense 
Summary Chart

The Expense Report Summary view provides an overall perspective of expenses 
incurred on a particular project. The Expense Summary Chart shows a graphical 
representation of the cumulative expenses for a selected project. The following 
procedure explains how to display the summary and the chart. 

NOTE: The Expense Summary Chart does not reflect any adjusted values.

To view the Expense Report Summary and Expense Summary Chart

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which expense report information is 
associated.

4 Click the Time and Expense view tab.

5 In the Time and Expense list, from the Show drop-down list, select Expense 
Summary.

The information displayed in the Expense Summary list shows you the reported 
expenses per expense report. 

6 Scroll down to view the Expense Summary chart. 

By default, the chart shows the amount of expenses per employee per month, 
displayed as a bar graph with color-coding.

If you want, you can modify the way the data is represented by using the drop-
down lists to change the information. You can also move your cursor over the 
different bars to get additional information on expenses logged by a particular 
employee.

7 To view additional information, click the Expense Report Name hyperlink in the 
Expense Summary list.
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Viewing an Expense Adjustments Chart
The Expense Adjustments Chart shows a graphical representation of the 
adjustments made for a selected project. The following procedure explains how to 
display this chart.

To display the Expense Adjustment Chart

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects List, select the project that has the adjustments you want to view.

4 Click the Time and Expense view tab.

5 From the Show drop-down list in the Time and Expense list, select Expense 
Adjustments.

6 Scroll down to view the chart. 

By default, the chart shows the amounts of adjustments per employee per 
month, displayed as a bar graph with color-coding.

If you want, you can modify the way the data is represented by using the drop-
down lists to change the information. You can also move your cursor over the 
different bars to get additional information on the adjustments made by a 
particular employee.
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This chapter describes agreements, and provides a business scenario and end-user 
procedures.

Agreement generation automatically incorporates specific project and resource 
information into the agreement, significantly decreasing the time and effort 
required to generate agreements. 

The automatic agreement generation process incorporates specific project and 
resource information into the agreement. This feature allows you to create accurate 
and consistent agreements reflecting your organization’s best practices and industry 
standards and share these standards with everyone on your team.

Use the agreement generator to populate customer information against a standard 
set of templates. The templates can be modified and customized as required by your 
administrator. 

For information about invoice agreements, see Siebel Field Service Guide.
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Business Scenario for Agreements
This scenario provides an example of a workflow performed by an engagement 
manager. Your company may follow a different workflow according to its business 
requirements.

The engagement manager at a large consulting company has set up the agreement 
generator to automatically pick out the appropriate resource and project 
information and populate it directly into the standard agreement template. When 
she creates an agreement, the application automatically populates the agreement 
line items with the resource requirements she identified in her Team Workbook. She 
now has the flexibility to edit the line item details as needed. She has set up the 
major parts of the agreement, and she now wants to generate the agreement. By 
selecting the Generate Draft button, she generates a draft version for her review. The 
document is customized with the customer’s information. The engagement 
manager can edit it as needed and then submit it for review and approval as 
determined by a predefined workflow process.
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Example Process for Agreements
This is an example of a process an end user might follow for managing agreements. 
Your company may follow a different process according to its business 
requirements. For information about administrative tasks such as creating 
agreement templates, see the chapter on proposals in Siebel Applications 
Administration Guide.

1 Create an agreement. For information, see “Creating an Agreement” on page 220.

2 Add line item details. For information, see “Adding Line Item Details to an 
Agreement” on page 221.

3 Generate documentation with an agreement. For information, see “Generating 
Documentation with an Agreement” on page 222.

4 Add an attachment to an agreement. For information, see “Adding Attachments to 
Agreements” on page 223.
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Creating an Agreement
An agreement is a representation of terms for services agreed upon between the end 
user and the customer.

To create an agreement

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the agreement will be 
generated.

4 Click the Agreements view tab.

5 In the Agreements list, add a new record.

6 Complete the necessary fields.

NOTE: End users can also create an agreement from the Agreements screen. When 
creating an agreement from the Agreements screen, end users must remember to 
associate the agreement with the project.
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Adding Line Item Details to an Agreement
After the agreement is created, end users can add line items to it. These line items 
are the products or resources that are being committed to the agreement. End users 
have probably already added roles to the Team Workbook to define the project 
team. Now they need to create a contract for that project. It is a good idea to create 
one line item for each role that was defined in the Team Workbook for this project. 
The Project Resource field in agreement line item records allows end users to link a 
team workbook role to a line in the agreement.

To add line items

1 Navigate to the Agreements screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Agreements list, click the Name hyperlink of the agreement you want to 
add line items to.

4 In the Line Items list, add a new record.

5 In the Product field of the new record, click the select button.

6 In the Pick Product dialog box, query for the product or resources that you are 
adding to the agreement and then click OK.

7 Click the Line Detail subview tab.

8 In the Line Detail form, click the show more button.

9 In the Project Resource field, click the select button.

10 In the Pick Parent Role dialog box, select the role you want to add to this 
agreement and click OK.

NOTE: This automatically populates the Est. Hours, Rate, Discount %, and 
Effective Rate fields in the Agreement Line Items field and also in the project’s 
Team Workbook.

11 In the Line Detail form, complete any additional fields.

NOTE: Continue Step 3 through Step 10 until you have added each role from the 
Team Workbook to the agreement.
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Generating Documentation with an Agreement
After the details of the agreement have been established, end users can then create 
a draft of the documentation to be reviewed. Once the agreement has been 
approved, it can be sent to the customer for official signoff. 

NOTE: End users can also generate a statement of work using this procedure.

To generate documentation with an agreement

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project from which the agreement was generated.

4 Click the Agreements view tab.

5 In the Agreements list, click the Name hyperlink of the appropriate agreement 
document.

6 In the Line Items list, add any line items as needed.

7 Click the Documents view tab.

8 In the Documents list, add a new record.

9 In the new record, type in a name for the document.

10 From the Template drop-down list, select the template you want to use for this 
agreement.

11 In the Documents list, click Auto Document.

This automatically imports the data required for the document template.

12 In the Documents list, click Generate Draft.

A draft agreement is generated in Microsoft Word or Lotus WordPro.

NOTE: You can also create agreements from the Agreements screen.
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Adding Attachments to Agreements
End users can attach documents to an agreement. For information on adding 
attachments, see Fundamentals.
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This chapter describes project financials and project revenue schedules and 
forecasting and provides a business scenario and end-user procedures.
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Financials Overview
Tight integration with back-office systems allows you to take project, time, and 
expense data from the Siebel Professional Services Automation module to create 
client invoices and track accounts receivable in a billing system of your choice. 
Client invoice information and payment status can be mapped back to Siebel 
Professional Services Automation from the billing system so that management can 
both understand performance against project budgets and identify where help is 
needed in soliciting payment from clients.

Project Revenue Schedules and Forecasting
Each professional services organization requires various ways of looking at revenue. 
One level of management may be interested in the margins of their most important 
projects over time while another organization might focus more heavily on 
projections or bookings. Across these varied levels of management, organizations 
might choose to focus on monthly billing, one time revenues, or recurring revenue 
streams. Revenue schedules were designed with exactly these requirements in 
mind. 

Project managers can associate multiple types of revenue with a project with each 
revenue schedule item. For example, booked, forecasted, backlogged, and burned.

Just as important as tracking data for individual projects is the ability to analyze it 
in the aggregate. Revenue analysis allows you to instantly view a graphical 
representation of the health of a project. With the ad-hoc reporting of the various 
revenue streams and timing by account, location, or project type, you are better 
equipped to make more informed and more timely business decisions to help 
maximize resource utilization and profitability.

For more information on forecasting, see Siebel Forecasting Guide.

Invoices
For professional services organizations, invoicing is an important aspect of their job. 
After performing services or providing products, invoices must be created for 
customers. Time and expense are the main factors behind creating invoices, and 
each invoice can store line items for time and expense logged against a project.
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Business Scenario for Project Financials
This scenario provides an example of a workflow performed by an engagement 
manager. Your company may follow a different workflow according to its business 
requirements.

The engagement manager at a large consulting company is responsible for a new 
project’s primary revenue value. Initially, this revenue amount for the project may 
be determined by early conversations with the client about scope, budget, and other 
high-level parameters. As the project progresses, she gathers greater knowledge of 
the customer’s needs.

The engagement manager begins to add revenues to the project manually. She then 
realizes that she has multiple revenues that need to be added. She uses SmartScripts 
to add these multiple revenues because SmartScripts makes it easier. She could also 
add multiple revenues using revenue plans. She shows her manager the project 
revenue spreadsheet, the project revenue chart, and the financial profile so he can 
see a detailed overview of the financials of the project. 

After she has reviewed and approved each submitted time and expense reports, she 
is ready to generate invoices to the customer. Time and Expenses on a project can 
be created as lines on an invoice.
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Example Process for Project Financials
This is an example of a process an end user might follow for project financials. Your 
company may follow a different process according to its business requirements. For 
information on administrative procedures related to revenues, see Siebel Forecasting 
Guide.

1 Add a project revenue. For information, see “Adding a Project Revenue” on 
page 229.

2 Add project revenues using SmartScripts. For information, see “Adding Project 
Revenues Using SmartScripts” on page 230.

3 Add project revenues using revenue plans. For information, see “Adding Project 
Revenues Using Revenue Plans” on page 231.

4 View the project revenue spreadsheet. For more information, see “Viewing the 
Project Revenue Spreadsheet” on page 232.

5 View the project revenue chart. For more information, see “Viewing the Project 
Revenue Chart” on page 233.

6 View financial profile information. For more information, see “Viewing Financial 
Profile Information” on page 234.

7 Add project invoices. For more information, see “Adding Project Invoices” on 
page 235.
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Adding a Project Revenue
End users can add revenues to projects. These revenues represent revenue line 
items in various stages.

To add a new project revenue

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the revenue will be added.

4 Click the Revenues view tab.

5 In the Revenues list, add a new record.

6 Complete the necessary fields.
Version 7.5, Rev. A Siebel Professional Services Automation Guide 229



Project Financials

Adding Project Revenues Using SmartScripts
Adding Project Revenues Using SmartScripts
If there are multiple revenues to add to a project, end users may want to use 
SmartScripts to add them. SmartScripts allows end users to enter multiple revenues 
without having to add them one at a time.

To add project revenues using SmartScripts

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 Select the project to which you are adding revenues, and click the Revenues view 
tab.

4 On the Revenues view tab, click the menu button, and then click Script. In the 
SmartScripts screen in the Revenue Schedule - Date Range form, complete the 
necessary fields, and then click Next.

5 In the Revenue Schedule - Default Values form, complete the necessary fields, 
and then click Next.

6 In the Revenue Schedule - Default Values form, complete the necessary fields, 
and then click Next.

7 In the Revenue Schedule - Amounts form, complete the necessary fields, and 
then click Finish.

The appropriate revenue records are calculated and added to the Revenues list. 

A set of revenues created using SmartScripts includes the same Group ID and 
thus are each included in the same spreadsheet record when the end user 
navigates to the spreadsheet view.
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Adding Project Revenues Using Revenue Plans
Revenue plans come from revenue templates created by administrators to be used 
to create a series of recurring revenues or a particular group of revenues.

NOTE: Values entered by end users at the Revenue Plan level for quantity, price, and 
revenue are multiplied by the value in the Multiplier field defined by the 
administrator in the revenue template, and the results populate the detail records.

To use a revenue plan

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 Select the project you want to associate with a revenue plan, and then click the 
Revenue Plans view tab.

4 Click New in the Revenue Plans list.

5 In the new record, select a revenue plan from the Template drop-down list.

The applicable revenue items and proposed period appear in the Revenues 
subview beneath the Revenue Plans list.

NOTE: End users can override the revenue plan detail data as needed.
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Viewing the Project Revenue Spreadsheet
The project revenue spreadsheet is a useful way to examine a project’s revenues. 
Data is organized in a spreadsheet which can make viewing the revenues simpler.

To view the project revenue spreadsheet

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project for which the information will be displayed.

4 Click the Revenues view tab.

5 In the Revenues list, from the Show drop-down list, select Spreadsheet.

Your data is displayed in spreadsheet form.
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Viewing the Project Revenue Chart
The chart view provides a graphical representation which allows end users to 
analyze revenue data.

To view revenue data using the Chart view

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project for which the information will be displayed.

4 Click the Revenues view tab.

5 In the Revenues list, from the Show drop-down list, select Chart.

Your data is displayed in graphical form. Summary values for each chart element 
will be displayed by the mouse-over feature.

NOTE: Use the By and Then drop-down lists on the Chart view to summarize 
your data by a variety of segments.

6 You can change the look and information displayed on the chart by selecting 
different values from the Show, By, and Then drop-down lists. For more 
information about using the Chart view, see Fundamentals.
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Viewing Financial Profile Information
To gain an overall perspective of a project’s financial information, status, and 
progress, end users can go to the Financial Profile view.

To view financial profile information

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the financial profile data will 
be viewed.

4 Click the Financial Profile view tab.

The Financial Profile form displays financial information related to the selected 
project.
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Adding Project Invoices
After end users have provided products and services (time and expenses) on a 
project, they need to create an invoice. Each invoice can store line items for time 
and expenses logged against a project. 

To add an invoice to a project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select the appropriate view.

3 In the Projects list, select the project with which the invoice will be associated.

4 Click the Invoices view tab.

5 In the Invoices list, add a new record.

6 Complete the necessary fields.
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